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Overview

Overview

The Line Item Modeling solution in OneStream is designed to configure diverse FP&A needs for
precise line-item planning throughout your organization. The solution empowers users to build
detailed, driver-based operational plans directly within the OneStream platform. Designed for
agility, scale, and business ownership, it enables granular modeling across operational domains
like workforce, sales, capital, and contracts, with full control over logic, security, and performance
with minimal IT assistance required. The solution leverages formulas and various drivers to
compute data, which is then presented in structured plans for reporting purposes. It can be used
independently or combined with other OneStream solutions based on your requirements. This

solution offers three different configurations depending on your planning needs:

* Workforce Planning: This configuration aids in workforce budgeting, forecasting, and
analysis, providing you with an efficient means of managing human resources. The
Register uses defined start and end dates to perform calculations and includes a built-in
transfer feature that enables you to manage employee movements across different areas of

the organization.

* Fixed Term Planning: This configuration uses defined start and end dates in the Register
to perform calculations and can be used for date-driven operations that aren't tied to

specific individuals, such as travel planning, leases, subscriptions, or project planning.

* Duration Based Planning: This configuration uses a defined start date and duration to
perform calculations and can be used for duration-driven operations that aren't tied to a

specific end date, such as project level planning, contracts, grants or other engagements.

I NOTE: Line ltem Modeling is compatible with the Modern Browser Experience.

I NOTE: The Line Item Modeling solution supports all culture code settings.
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Setup and Installation

Setup and Installation

This section contains important details related to the planning, configuring, and installation of your

solution. Before you install the solution, familiarize yourself with these details.

See OneStream Solution Modification Considerations.

Dependencies
Component Description
OneStream 9.0.0 or Minimum OneStream Platform version required to install this
later version of Line Item Modeling.
Microsoft SQL Server Line Item Modeling requires an instance of Microsoft SQL Server
2017 or later 2017 or later.

Load Solution

1. Inthe OneStream Solution Exchange, go to OneStream Solutions and select the Line Item

Modeling tile.

2. Onthe Line Item Modeling Solution page, in the Platform Version drop-down menu,

select the appropriate OneStream Platform version.

3. Inthe Solution Version drop-down menu, select the most recent version. Click Download.

4. Log into OneStream.
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5. On the Application tab, go to Tools > Load/Extract.
6. Onthe Load tab, use the Select File buttons to locate the solution package. Click Open.
7. When the solution file name appears, click Load.

8. Click Close to complete.

Install Overview

Welcome to OneStream's Line ltem Modeling Installer. This powerful installer offers three
different configurations to install: Workforce Planning, Fixed Term Planning and Duration Based
Planning. You can also install multiple instances of the different configurations depending on your

planning needs.

Once the setup of your configuration type is complete, either by following the Setup Wizard or

importing a configuration file, a new dashboard is created as the configuration type and instance.

Install Configuration
Use the Line Item Modeling Installer in the OnePlace tab to install a planning configuration.

NOTE: Only administrators can set up the solution, adjust the settings and see the Line

Item Modeling solution Installer.
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i

Welcome to OneStream'’s Line Item Modeling Installer

Version PV300-SV120

Select planning configuration:

%

Workforce Planning

Enables planning of headcount,
compensation, and benefits across the
organization, supporting hires, transfers,
terminations, and employee movement

%

Fixed Term Planning

Model items with defined start and end
dates. Ideal for leases, projects, or
subscriptions where timing is critical to
planning accuracy.

%

Duration Based Planning

Plan over a fixed number of periods from a

start date. Perfect for contracts, grants, or
engagements with known durations but
flexible end dates.

over time using date-based tracking.

Uninstall or upgrade existing instance of Planning

Uninstall Line Item Modeling Installer

1. Goto Dashboards > Line Item Modeling > Line Item Modeling Installer.
2. Click the Install button below the type of planning configuration you want to install.

3. Inthe dialog box, click the PROCEED button.
NOTE: Once the configuration is installed, a new workspace and dashboard are

created as the configuration type and instance. You may have to refresh the

application to see the new dashboard on the OnePlace tab.
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4. On the configuration Welcome Page, click Install Tables.

NOTE: Each install of the configuration options will install in its own schema and

instance number. For example, Workforce Planning 1.

After tables are installed, you're directed to a welcome page to start your setup. You can either

use the Setup Wizard or the Configuration option.

Uninstall Installer

To uninstall the Line Item Modeling installer, click the Uninstall Line Item Modeling Installer link

on the installer welcome page.

I IMPORTANT: A dialog box will display to confirm if you want to proceed.

I NOTE: Current planning instances will remain installed.
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Instance Management

The Line Item Modeling Installer includes a centralized Instance Management capability for
administrators. This feature provides a clear and streamlined path to upgrade or remove existing
instances of planning configurations from a single location, improving maintainability and reducing

complexity.

To access the Instance Manager page, click the Uninstall or upgrade existing instance of

Planning link on the installer welcome page.

i

Welcome to OneStream'’s Line Item Modeling Installer

Select planning configuration:

Version PV900-5V120

Workforce Planning Duration Based Planning

Enables planning of headcount,
compensation, and benefits across the

organization, supporting hires, transfers,

terminations, and employee movement
over time using date-based tracking.

%

Fixed Term Planning

Model items with defined start and end
dates. |deal for leases, projects, or
subscriptions where timing is critical to
planning accuracy.

Plan over a fixed number of periods from a
start date. Perfect for contracts, grants, or
engagements with known durations but
flexible end dates.

Uninstall or upgrade existing instance of Planning

Uninstall Line item Modeling Installer
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Upgrade Instance

As an administrator, you can upgrade planning instances to the latest version from the Instance
Manager page. This process ensures your planning instance runs on the most current version
without requiring a full reinstall. The latest version of the solution will be installed on the same
instance number and carryover the workspace name and profile as well as existing data and

database tables.
I NOTE: Changing the workspace name in Line ltem Modeling is not recommended.

To upgrade a planning instance, follow the legend and corresponding instructions:

Instance Manager

Select an instance of planning to Upgrade, Uninstall Ul, or Uninstall Full.

e , b -
«© Sin o
Back to Installer

Upgrade Uninstall Ul Uninstall FULL
Planning Instance (6) T Version T
o Fixed Term Planning 2 PVa00 SV100
Uninstalled Fixed Term Plann.. N/ A
Uninstalled Workforce Planmni... N/ A
Workforce Planning 1 PVS00 SV100

1. On the Instance Manager page, select an instance.

2. Click the Upgrade button.

I IMPORTANT: A dialog box will display to confirm if you want to proceed.
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After installation is complete, the instance is ready to use without needing to use the setup wizard

again.

Uninstall Instance

As an administrator, you can uninstall planning instances from the Instance Manager page.

To uninstall a planning instance, follow the legend and corresponding instructions:

Instance Manager

Select an instance of planning to Upgrade, Uninstall Ul, or Uninstall Full

ri e
G 5 ]
Back to Installer

Upgrade Uninstall I Uninstall FULL

Planning Instance (6) T Version T

o Fixed Term Planning 2 PV900 SV100
Uninstalled Fixed Term Plann... N/A
Uninstalled Workforce Planni... N/A
Workforce Planning 1 PV200 S5V100

1. Onthe Instance Manager page, select an instance.
2. Click the Uninstall Full or Uninstall Ul button.

¢ Use the Uninstall Full button to remove all related data tables, data, workspaces
and workspace components, but retain business rules. The instance is removed from
the table.

¢ Use the Uninstall Ul button to remove all dashboards, but retain databases, related

tables and business rules. The instance name updates to start with Uninstalled.

I IMPORTANT: A dialog box will display to confirm if you want to proceed.
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Application Setup Options

The Setup Wizard provides a user-friendly, step-by-step process, ideal for first time setup or those
who prefer a more guided experience. The Configuration option offers more control for users who
are comfortable importing a configuration file that already contains all the solution settings in a

single JSON file. Review the sections below and select the option best suited to your setup needs.

NOTE: Only administrators can set up the solution, adjust the settings and see the Line

Item Modeling solution Installer.

Setup Wizard

Launch Setup Wizard: From your configuration Welcome Page, click the Start button to begin
the Setup Wizard. If this is the first time you are installing the solution, or you do not have a
configuration file generated from a previous version of the solution, the Setup Wizard is the

recommended option.

This section will guide you through setup of the Register, Accounts, and Security steps. The Setup
Wizard has built-in validations to make sure all necessary information is populated. In the Security
setup, dialog boxes will display if you skip over a step and inform you to go back and fill in any

missing criteria.

IMPORTANT: Any attribute named in the solution, such as Register Field Names,
Accounts, Global Drivers, Cube Drivers, Lookup Drivers and Formula Names, must be

unique from each other.
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88 5 D6 Register Definition Mo Definbion:
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Register

Step 1 of the Setup Wizard is the Register. This is a crucial tool that aids in the initial configuration
and ongoing management of your planning environment. It is designed to streamline the setup

process and make it easier to define your Register and the attributes within it.

Through the Setup Wizard Register, you can dynamically load your column definition and
configure a variety of settings, including display names, data type, control lists, and data

dimensions.

The Register portion of the Setup Wizard ensures that you can set up your Line Item Modeling

solution according to your specific business requirements.

Itis essential to review and update the settings in the Setup Wizard Register periodically to ensure

they remain aligned with any changes in your business operations or planning needs.

Register Setup

Register Definition: In this step, you will dynamically create the columns used for your Register.
These fields, for example, can come from your human resources (HR) source if you are in the
Workforce Planning solution. Some examples include Employee ID, Job Title, Department, and

Status. These columns within the Register Definition table will help define your Register:
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* Register Field Name: The column name that is imported from your .csv file.

* Display Name: The column name that will display on your Register. Display Name can only

contain letters a to z, numbers 0 to 9, underscore characters, and spaces.

* Data Type: Define the data types for each Register column. You have these options: String
(numbers or letters), Date, and Number. It is important to assign the correct Data Type for
your Register Field Names based on the data you intend to import into the Register later in

the planning process.

e Column Format: Define the formatting for each data type using the drop-down menu.
Formatting types include: decimal places (N#), dates and Percentages (P#). Choose from
the following: blank (default), NO, N1, N2, N3, N4, N5, N6, N7, N8, N9, MM/dd/yyyy,
dd/MM/yyyy, yyyy/MM/dd, PO, P1, P2, P3, P4, P5, P6, P7, P8 or P9.

NOTE: The assigned formatting for dates in the Register Definition will override

date formatting from a culture code.

¢ Date Assignment:

° For the Workforce Planning and Fixed Term Planning configurations, select a
Register field to have a start and end date assigned for your incremental and periodic

calculations.

° For the Duration Based Planning configuration, select a Register field to have a start
date and duration assigned for your incremental and periodic calculations. The

duration selection can only be an integer ranging from 0 to 2400.

* Allow Updates: You have the option to allow updates on certain columns. This will

determine which columns can or cannot be modified in the Register.

IMPORTANT: If this attribute is not assigned, you will not be able to edit

regardless of security permissions.
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* Required Column: Select which Register columns you want to be required when importing

and editing Register data.

* Member Definition: Define which member metadata you want to assign to a Register

column.

NOTE: If your member definition is using extensibility where there is more than
one dimension, and you want to plan at a more detailed level, you can define the
specific dimension in your member definition. For example,
U1#CC100.Base:Dim:Equipment Cost Centers Budget. Member definitions link
core dimensionality to the Register and provide data validations and security

options within the Line Iltem Modeling solution.

* Parameter Name: Provides the option to select a predefined parameter in your application

to assign to a Register column.
* Control List: Indicates if the Register column has control list values.

e Default Value: Define a custom default value for each Register column. If you input a value
that does not match the assigned data type or input a value that is not included in the
member definition, a dialog box displays. When a new row is added to the Register, the

default value populates for that field.

NOTE: If you have a default value assigned and import a new .csv file, the default

value is automatically applied to the column upon saving the Register.
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There is also a control list table next to the Register Definition table that enables you to populate
acceptable control list values for each Register field. For example, if you have a Register field
name of Region and you only have data for two regions, USA and Canada, you can input those
values in the table to make sure no other regions are accepted. When you assign a member
definition to a row in the Register table and save it, the control list automatically populates the
associated member definition values for that row which provides the option to assign security to

list members in step 3 of the Setup Wizard. See Security Setup.

Before importing, verify that the Register columns within your .csv file only contain letters a to z,

numbers 0 to 9, or underscore characters to avoid any issues or missing data in your Register.

To set up your Register, follow the legend and corresponding instructions:

o

Register Accounts Security

Register

To begin defining the Register, load your ‘Regster Definiion' file using a csv format. This should contain the column headers you wish to include
in the Register. Once the file is imported, you can apply other settings necess: your register columns.

Register Definition: |Select File o

O=5908 Register Definition Member Definition:

Register Field .. : Display Name : DataType : DateAssignment : AllowUpdates  : Required Column : Member Definit.. : ParameterName : Default Value : Column Format

Control List:

I

%50

< Page oft » » 50 v rowsperpage 0-00f0 rows <« Page oft ¥
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o

Register Accounts Security

Register

To begin defining the Register, load your ‘Register Definition’ ile using a csv format This should contain the column headers you wish to include
in the Register. Once the fil is imported, you can apply other settings necessary to configure your register columns.

Register Definition: PLNRegister.csv

@508 (1) 6 0 @  FResisterDeminiion @ (3] (0] (10] Member Definition:

5 ®

Register Field .. ¢ Display Name : DataType : DateAssignment : AllowUpdates  : Required Column : Member Definit.. : ParameterName : Control List i Default Value i Column Format 4650
[ Entity [ Eniey [ strina | [ M Y eresc Y ot usea [~ [ |
| Employectype | EmployeeTvpe | string | | | h| | Mot Used [ o | | ContolList Regon () T
EmployeelD Employee ID String [S] Not Used No import
Region Region String o o Not Used No
BusinessUnit Business Unit String 5] 5] Not Used No 5 5 980
CostCenter Cost Center String o [u} Not Used No Stored Value : Display Value
FTE FTE String o o Not Used No
[ Endoate [ End Date [ strina [ End Date 7 a] [ 8] [ [ Mot Used [ o [ |
[ startoate | start pate | strina | start pate h| O [ O | | ot used [ o | |
StartPeriod Start Period String 5] 0 Not Used No
JobTitle Job Title string o 5] Not Used No
EmployeeName Employee Name string o u] Not Used No
AnnualSalary Annual Salary string a} o Not Used No
HourlyRate Hourly Rate String ] o Not Used No
Col_401KPercent 401K Percent string o u] Not Used No
Employeelnstance  Employee Instance  String o o Not Used No
<« Page ofl » » 50 v rows perpage 1-17 of 17 rows <« Page of 1 »

mzm ©

1. Click Select File and a dialog box displays prompting you to upload a file. The Register
Definition will populate with the data and order of the .csv file. You can also manually add or

remove entries using the grid toolbar.

» ThisPC » Documents » PLMN

Mew folder

) Mame

E@ GlobalDrivers.csv

Planning.pdf

.':r PLN_Settings_Manifest_20240318-1841.json
E:ﬁ PLPRegister.csv

2. Once the table is populated, you will see a list of all your columns in the Register Definition

:Q

table. Set the member definition by clicking the Member Definition button =

The Member Filter Builder dialog box is displayed for member definition creation. Create

the member definition and then click the OK button.
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3. Copy the member definition in the text box created in step 2 and paste it into the Member
Definition column for the Entity row. Entity is a required field, and it should only be applied

to one Register Field Name.

NOTE: You can also assign a User-Defined (UD) member definition for other
Register field names based on your planning needs. This can be done through the
Member Filter Builder as well. Only one token type can be assigned to a Register

Field Name.

4. Selectthe Data Type for each Register Field Name. Choose from the following: Number,

String or Date.

5. Inthe Date Assignment column, select a cell and use the drop-down menu to select a
Start Date and End Date for your corresponding Register Field Name. Start Date and End

Date are required fields.

NOTE: The Workforce Planning and Fixed Term Planning configurations use the
Start date and End date selections. The Duration Based Planning configuration

uses a Start date and a Duration selection.

6. Select the checkbox in the Allow Updates column for each Register Field Name you want
to allow editing access for. Leaving it blank means that the field is read-only and cannot be

updated.

7. Select the checkbox in the Required Column column for each Register Field Name to
define if data is required when importing and editing the Register data during the planning

process.

8. Setting the Parameter Name for each Register Field Name is optional. Set them by
selecting a row and using the drop-down menu in the Parameter Name column. You can

also search for a parameter by using the drop-down menu and then typing in the text box.

9. Inthe Default Value column, select a value for each Register Field Name.
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10. Inthe Column Format column, select a value for each Register Field Name. Choose from
the following: blank (default), NO, N1, N2, N3, N4, N5, N6, N7, N8, N9, MM/dd/yyyy,
dd/MM/yyyy, yyyy/MM/dd, PO, P1, P2, P3, P4, P5, P6, P7, P8 or P9.

11. (Optional) You can use the control list table next to the Register Definition table to populate

acceptable values for each Register field as well as the stored value and display value.

NOTE: The control list column in the Register Definition table indicates if a
Register column has control list values. This will update automatically upon
clicking the Save or Next button on the Setup Wizard or by going to Settings >
Register Definition and clicking the Update button.

12. Click the Next button and a dialog box displays. Select Proceed or Cancel.

There are built-in validations, so you will not be able to move forward if there is missing or
incorrect information entered in Register Definition table. For example, if you are missing a
Display Name, you have two different dimensions tokens being used in the same column, or if you

have the same dimension token on two different columns, a validation message will display.

Accounts

In OneStream's Line Iltem Modeling solution, the term Accounts often refers to the accounts that
are set up and used in formula creation and where the calculated values are stored. These
accounts are crucial for ensuring the calculated values in your plan table are placed in the
appropriate account. You can use the same account name and description as your application
metadata or add accounts that may not be in your account structure but will help in calculating

values on a more detailed level.

Before you import, verify you are using a .csv file. The column names on the .csv file must match

the table shown in the solution.
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IMPORTANT: Any attribute named in the solution, such as Register Field Names,

Accounts, Global Drivers, Cube Drivers and Formula Names, must be unique from each
other.

To import Accounts, follow the legend and corresponding instructions:

© ©

Register Accounts Security

Account

Calculated results for your plan must be placed in its assigned account in your solution. To define accounts in your formula, load your ‘Accounts
file which contains all the account numbers you wish to use in your solution.

.

Impart

®-=+—=xo@

Account Name i Account Description

Ll <« Page of1 » 2l 50 ¥ rows per page 0 -0 of 0 rows

Back MNext

1. Click the Import button and a dialog box displays prompting you to upload a file. You can

also manually add or remove entries using the grid toolbar.

2. Click the Next button.

NOTE: There are built-in validations so you will not be able to move forward if

there are issues, such as duplicate account names.
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Security Setup

OneStream's Line ltem Modeling Installer allows you to have different configuration types and set
up security for each using the Wizard Security Groups, ensuring secure access control and data
protection. These groups define the level of access and permissions each user or user group has
within the system, enabling administrators to effectively manage who can view, edit, or approve
data. By structuring user access rights through the Security Groups, organizations can maintain
control over sensitive information and prevent unauthorized alterations. This feature enhances
the security of the planning process and fosters accountability and proper data management
within the organization. It is an essential component for businesses looking to safeguard their
data while promoting a collaborative planning environment. See Security to adjust Security

groups.

NOTE: The Manage Transfers action is only available in the Workforce Planning

configuration.

To set security groups for Actions, follow the legend and corresponding instructions:
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@ O ©

Register Accounts Security

Actions  Register Columns

Actions : Security Group

Add Register Data (Bulk) Administrators Q

| Administrators
e Edit Register Data Administrators e L

[_] Everyone

Delete Register Data (Bulk) Administrators ) Test

Delete Register Data Administrators

Manage Transfers Administrators

View Audit Log
Manage Filters

Calculate Plan

Administrators
Administrators

Administrators

View Plan Administrators
Lock Plan Administrators
Unlock Plan Administrators
Manage Plans Administrators
View Drivers Administrators
Manage Drivers Administrators
View Formulas Administrators
Manage Formulas Administrators

oo

1. Click the Actions button.
2. Selectarow.

3. Select security groups.

TIP: You can search for a security group by typing in a security group name and

clicking the Search button.
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4. Click the Save button. You can revert your security group selections by clicking the Undo

button.

IMPORTANT: You need to click the Save button after each Action security group

selection.

To set the security groups for Register Columns, follow the legend and corresponding instructions

below:
Register Accounts Security

Actions Register Columns

Register Column : Column Visibility : Control List Source :
e Entity Everyone
EmployeeType Everyone
EmployeelD Everyone
Region Everyone
BusinessUnit Everyone
CostCenter Everyone
FTE Everyone
EndDate Everyone
StartDate Everyone
StartPeriod Everyone
JobTitle Everyone

=

Entity e

Column Visibility = Control List

Q

[ Administrators
Everyone
[ Test

Line Item Modeling Guide
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1. Click the Register Columns tab.
2. Selectarow.
3. Click the Column Visibility tab.

4. Select security groups.

TIP: You can search for a security group by typing in a security group name and

clicking the search button.

5. Click the Save button. You can revert your security group selections by clicking the Undo

button.

IMPORTANT: You need to click the Save button after each Action security group

selection.

To set the security groups for control list values, follow the legend and corresponding instructions:
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© © ©

Register Accounts Security

Actions  Register Columns

Register Column Column Visibility i Control List Source : Region 9

Enlty Everyone Semier DErHon Column Visibility Control List _Rﬂd e

EmployeeType Everyone -

Employesi Eyaryona DisplayValue  : Read Only = Q
e Region Everyone Custom Control List o — — @ 2:::”:3"”5

BusinessUnit Everyone g

CostCenter Everyone

FTE Everyone

EndDate Everyone

StartDate Everyone

StartPeriod Everyone

JobTitle Everyone

EmployeeName Everyone

AnnualSalary Everyone

HourlyRate Everyone

Col_401KPercent Everyone

Employeelnstance Everyone

EmployeeStatus Everyone

(o= W

1. Click the Register Columns tab.
2. Select a row with control list values.
3. Click the Control List tab.

4. Selectarow.

5. Click the Read Only tab to set read-only permissions or click the Read/Write tab to set

read/write permissions.

6. Select security groups.

TIP: You can search for a security group by typing in a security group name and

clicking the search button.

7. Click the Save button.
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IMPORTANT: You need to click the Save button after each Action security group

selection.

8. Click the Finish button.

The Control List Source column in the Register Columns tab indicates if control list values are
populated from a Member Definition or custom control list. Security settings for members on the
Entity dimension cannot be modified in Line Iltem Modeling. These settings are inherited from the

dimension library and reflect the security applied there.

NOTE: Security can only be applied to member definitions or custom control lists but not

to parameters.
The following table details the actions you can set security groups for.

NOTE: OneStream Administrators will not automatically have rights to the inner
workings of this solution. If you have Administrators responsible for any of the Actions
listed below, you must assign the Administrators group to the action or include those
individuals to the security groups assigned. This also applies to row level security on the

Entity, UD's or Control List items.

Actions User Function

Add Register | User can import Register bulk data.
Data (Bulk)

Edit Register | User can edit Register data. Edits include updating a row that exists and

Data adding a row.
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Actions User Function

Delete User can delete Register bulk data.

Register

Data (Bulk)

Delete User can delete Register data. This permission allows specific users to

Register delete an existing row. If a user has permission to Delete Register Data, they

Data also have Edit Register Data permission.

Manage User can execute transfers and is not data dependent, meaning this role is

Transfers not tied to column or member security. The user assigned to this action can
apply the execution of transfers globally within any intersection of data. This
action is only available in the Workforce Planning configuration.

View Audit User can view the Audit Log.

Log

Manage User can create, edit, copy or delete Register filters.

Filters

Calculate User can calculate plan data.

Plan

View Plan User can view plan data.

Lock Plan User can lock plans.

Unlock Plan User can unlock plans.
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Actions User Function

Manage User can create, edit, copy, calculate or delete plans.

Plans

View Drivers User can view Global Drivers, Lookup Drivers and Cube Drivers.

Manage User can import Global Drivers, Lookup Drivers and Cube Drivers.
Drivers
View User can view formulas.
Formulas
Manage User can create, edit, copy or delete formulas.
Formulas
Configuration

The configuration option enables you to import a file that already contains solution settings from a
different instance or another application and apply them automatically. The naming of the

configurations is based on the specific planning use case:
* PLNA1 - First instance and schema Fixed Term Planning
* PLNB1 - Firstinstance and schema of Workforce Planning

* PLNC1 - Firstinstance and schema of Duration Based Planning
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IMPORTANT: You cannot import a configuration file into a planning instance that was
created from a different planning configuration. For example, you cannot import a
Workforce Planning configuration file into a Fixed Term Planning instance of the

solution.

1. From the main Setup Wizard dashboard, click the Import File button to begin the setup
process. You can only access the import of a configuration file during the Setup Wizard

process.

2. Select the file you want to import and then click the Open button.

¥ ThisPC » Documents » PLMN

Mew folder
Mame

D PLM_Configuration_v3_20241209-1032.json

NOTE: When you import a configuration, Cube Driver and Lookup Driver values won't
display in the preview table until you add Register data. Your Cube Driver or Lookup
Driver is trying to compare values that are in the Register against values that are in a
Cube or Lookup table so data needs to exist in the Register for that comparison to

happen.
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Settings

In OneStream's Line Iltem Modeling solution, the Settings drop-down menu enables the
administrator to access the settings for Register Definition, Accounts, and Security. If further
adjustments need to be made to the settings, you can do so from the respective dashboards. In
addition to accessing your current solution configuration, this solution offers a way to export your
configuration and apply it to another application or instance. See Configuration. As an
administrator, you can export your configuration JSON file to capture additional settings, such as
Global Drivers, Cube Drivers, Lookup Drivers or Formulas, which are detailed in the

documentation. The standard Uninstall Full option is available in Settings as well. See Uninstall.

To access the settings menu, follow the legend and corresponding instructions:

Register Formulas Settings o Help
Register Definition
Account

Security e

Configuration
Uninstall
1. Hover your cursor over the Settings menu.

2. Choose from the following settings menus: Register Definition, Account, Security,

Configuration, and Uninstall.
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Register Definition

The Register Definition menu enables you to add new member definitions and make row and

column updates to your Register Definition. After your changes are made you can click the Save

button on the Register Definition table and your changes will only be reflected in the Register

Definition table. To save your changes and apply them throughout the solution, click the Update

button. If you update a data type, you are notified that the Register data will be removed because

a new structure for the Register Definition has been established and you can either proceed or

cancel.

I NOTE: To change the start and end date assignments, Register data must be removed.

Register Definition

Register Definition: PPL_UKG_SmallData-StartEnd.csv

© =% 5 0B

Register Field Name ¢ Display Name
EmployeelD EmployeelD
FirstName FirstName
LastName LastName
Entity Entity
Region Region
CostCenter CostCenter
Title Title
Status Status
FTE FTE

- « Page ofl » gl

Register

Register Definition

¢ Data Type ¢ Date Assignment

String
String
String
String
String
String
String
String

Number

50 ~ rows per page

Formulas

¢ Allow Updates

[ I < I < ]

(< < I < ]

1-16 of 16 rows

Settings

Member Definition:

Control List:

< <« Page

Help

of 1

There are built-in validations preventing you from moving forward if there is missing or incorrect

information entered in the Register Definition table or control list table. Some examples are:
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* You are missing a display name
* You have two different dimensions being used in the same column

* You have control list values that don't match the data type of the Register column

Register Definition Table

In the Register Definition table, you can insert a new row, remove row, cancel all changes prior to
saving and save any updates without having to do a bulk .csv file import of Register fields. Once
your changes have been saved and you click the Update button, your Register reflects the

updates made in the Register Definition.

The column order defined in the Register Definition table is applied throughout the solution. When
a new row is added or the .csv file is reloaded, any new fields or fields in use will automatically be
shifted to the bottom of the Register Definition and, by default, display on the far right side of the

Register. The grid component will allow you to modify your column order in its saved state.

* Tolnserta Register row, click the + button. Enter the Register field and display name

and update any other column attributes.

* Toremove a Register row, click the = button.

* Tocancel all changes prior to saving, click the o button.

* To save, click the H  pution.

NOTE: There may be instances that will prevent an update to your Register Definition in
which you will receive a message that describes why it's prevented. For example, if you
are trying to delete a Register Field that is in-use, you will receive a message stating

where it's being used (a Register Filter Group, Driver, or Formula).
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Control List Table

In the Control List table, you can perform the following actions:

Control List: Grade o i
Import
® 06
= —:x v B
Stored Value : Display Value
1 Grade Level 1
2 Grade Level 2

1. Import a .csv file

NOTE: File must have the Stored Value and Display Value columns in that order.
Importing a .csv file enables you to load many control list values at once.

2. Insert Row

3. Delete Row(s)

4. Cancel all changes prior to saving

5. Save

The control list table enables you to input a stored value and display value to manage control list
values with greater detail and description. The data type selected in the Register Definition must

match the data type of the control list values. You cannot enter a date value in a control list.

NOTE: You cannot remove control list values that are used in a Register filter group or

formula.
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If you make an update in the Control List table and click the Save button, the updated control list

values will only be reflected in the Register Definition.

IMPORTANT: Once the changes have been saved, if you want the update to be

reflected throughout the solution, click the Update button.

Account

The Account menu enables you to view, import, add, update, and remove accounts. After any

updates are made, click the Save button.

Click the Import button to load any bulk changes to your .csv file.

NOTE: If an account is currently being used in a formula, the account automatically
remains in the table. All other accounts are removed, and the table then includes the

new .csvV file as well as the accounts used in formulas.

In the Accounts table, you can perform the following actions:

Account

+
“~ 00 0 0
@—=+_=KD@

Account Name : Account Description
50200 Monthly Salary
50210 Salaries Hourly
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1. Insert Row

2. Delete Row(s)

3. Cancel all changes prior to saving
4. Save

NOTE: You cannot remove an account that is used in a formula; however, you can edit

the Account Description of an account that is currently being used in a formula.
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Security

Security in OneStream's Line Item Modeling solution is a fundamental component designed to
protect sensitive data and ensure access control. The Security Groups feature enables
administrators to define access levels and permissions for each user or user group, providing
granular control over who can perform specific actions, access certain pages, or view and edit
data. Furthermore, OneStream's Line ltem Modeling solution complies with industry-standard
security protocols, ensuring your data is safeguarded according to best practices. This robust
security framework enables organizations to leverage the power of the Line Item Modeling tool

confidently, knowing their data is well-protected.

You can add, save, edit, or remove Security Groups. Multiple security groups can be assigned to

Actions or Register Columns for more control of what users can have access to. The Register

Columns shown are based on the .csv file load from the Register setup.

For additional information on updating security groups for Actions, Register Columns and Control

List values, see Security Setup.
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Delete Reqister D

Manage Transfers
View Audit Log
Manage Filters

Calculate Plan

Administrators
Administrators
Administrators
Administrators

Administrators

iew Plan Administrators
Lock Plan Administrators
Unlock Plan Administrators

Manage Plans
\iew Drivers
Manage Drivers
View Formulas

Manage Formulas

Administrators
Administrators
Administrators
Administrators

Administrators

People Planning Register Formulas Settings Help
Security

Actions  Register Columns

Actions Security Group
Add Register Data... Administrators Q
Administrat
Edit Register Data Administrators | AOMnErg:
[] Everyone
Delete Reqister D Administrators (] Test

NOTE: The Manage Transfers action is only available on the Workforce Planning

configuration.

Configuration

Configuration enables you to package and reuse the current settings of your solution, such as:
Register Definition, accounts, security, Register group filters, Global Drivers, Cube Drivers,
Lookup Drivers, Formulas and Plan criteria. Using a Configuration can be helpful when switching
from a development environment to a production environment, allowing for faster implementation

and less manual setup.
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The naming of the configurations is based on the specific planning use case:
* PLNA1 - Firstinstance and schema Fixed Term Planning
* PLNB1 - Firstinstance and schema of Workforce Planning
* PLNC1 - First instance and schema of Duration Based Planning

IMPORTANT: The Audit Log, Register and Plan data cannot be exported with a

configuration file.

NOTE: When you import a configuration, Cube Driver and Lookup Driver values won't
display in the preview table until you add Register data. Your Cube Driver or Lookup
Driver is trying to compare values that are in the Register against values that are in a
Cube or Lookup table so data needs to exist in the Register for that comparison to

happen.

To export a configuration, follow these instructions:

1. Click the Export button.

Register Formulas Settings Help

Configuration

By clicking ‘Export’, you will generate a Configuration file. This file will contain
the following settings of your current solution: Register Definition, Accounts,
Security, Register Group Filters, Global Drivers, Cube Drivers, Lookup Drivers,
Formulas, and Plan Criteria.

2. Inthe File Explorer, select the folder location to store the configuration file, and click the

Select Folder button.
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NOTE: A placeholder file name is given to the configuration file in the following format:
Solution/Type Code/Instance_Configuration_Version Number_Timestamp. For
example, PLNB6_Configuration_v1_ 20250929-1115.json.

Uninstall

To uninstall a planning configuration, follow the instructions:
1. Hover your cursor over the Settings menu.
2. Inthe drop-down menu, select Uninstall.

3. Click the Uninstall Full or Uninstall Ul button.

* Use the Uninstall Full button to remove all related data tables, data, workspaces

and workspace components, but retain business rules.

¢ Use the Uninstall Ul button to remove all dashboards, but retain databases, related

tables and business rules.

I IMPORTANT: A dialog box will display to confirm if you want to proceed.

Uninstall

The ‘Uninstall UI' option removes all dashboards, but databases and related tables
will remain intact,

The ‘Uninstall Full’ option remaoves all the related data tables, data, workspace and
workspace components.
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NOTE: Business rules and extenders remain if you uninstall. Re-Installing the

solution overwrites any existing business rules and extenders.
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Register

The Register in planning and management is usually a record keeping tool that tracks various
details and data points. In the context of Workforce Planning, it refers to a tool for managing
details about personnel, such as their roles, skills, and schedules. It might be used in human
resources or project management to ensure that the right personnel are allocated to the right
tasks. You can import and modify data and then calculate and analyze that data to make

decisions about various types of planning.

Register Formulas Settings
Import & Modify
e T E ° a Select group
40d Data Manage Filters Sprasdshest Delste Al AuditLog MIEmployees; ¥
® 5 5 0 B Register
Editable : EmployeelD . Instance : FirstName : LastMame :  Entity : Region

Import and Modify

There are two options for importing data into the solution: using a .csv file or a connector.
1. Prepare your data: Before importing, ensure your data is in the correct format.

CSV import:

Organize your data in a .csv file, with each column representing a different data point (for

example, name, role, schedule), and each row representing a different individual.

I NOTE: Your column order needs to match the Register order.
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Connector:

The connector option uses a business rule to connect to an external source like an HR

system.

An application business rule template is preconfigured for loading from a connector but
requires you to replace information with your own implementation to populate the Register
structure. Each instance of a configuration has its own business rule. To access this
business rule template, go to Application > Business Rules > DashboardExtender and
then locate your planning configuration import Register connector instance
[ConfigurationName]lmportRegisterConnector[InstanceNumber]. See the example below
for the first instance of the Workforce Planning configuration

(WorkforcePlanninglmportRegisterConnector1):

@) Business Rules - WorkforcePlanninglmportRegisterConnector1

DIk OWHI|®|H B
~x STRPLN_SolutionHelper

Formula
% TCR10_CustomHelper BropSmes -

% TCR10_ImportExportHelper & * R = 2| ¥ &
4% TCR10_SolutionHelper ) 22 _plnController = new(si, plnType, plnInstance);
23
+7 TDM_SolutionHelper Vo try
V% TLP10_ImportExportHelper 25 {
& TLP10_SolutionHelper 26 switch (args.FunctionType)
= 27 {
% TLP20_CustomEvents 28 case DashboardextenderFunctionType. LoadDashboard:
V& TLP20_importExportHelper 29 throw new NotImplementedException();
" 30 case Di ionType.C: lectionChanged:
VX TLP20_SolutionHelper 31 if (args.FunctionName.XFEqualsIgnoreCase (" ImportRegisterData”))
V% TLP30_ImportExportHelper =2 {s
33 return ImportRegisterData(si, globals, api, args);
P & g P €
V& TLP30_SolutionHelper 24 1
V& TLP40_ImportExportHelper 35 break;
6 ase DashboardExtenderFunctionType.SqlTableEditorSaveData:

2 TLP40_SolutionHelper throw new NotImplementedException();

& TRD_SolutionHelper 38 +
39 t 11;
JF TXM_AdvFilterguilder =y ) return nu
F TXM_EventHandler 41 B catch (Exception ex)
/7 TXM_FilterHelpers {
a3 throw ErrorHandler.Loghirite(si, new XFException(si, ex));
7 TXM_HelperClasses a4 1

+F TXM_ImportexportHelper a5 }
16

F TXM_Modules

+F TXM_SetupHelper

public object ImportRegisterData(SessionInfo si, BRGlobals globals, object api, DashboardExtenderArgs args)

V7 TXM_SolutionHelper
F UTM_DocMgrHelper 71 Replace with your own implementation, create a DataTable that matches your registry structure and pass it to the plaController
% UTM_EventHandler DataTable dt = nen();
¥ UTM_ImportExportHelper 7/ Passing the DataTable to the planning controller will import the data into the table
wvar result = _plnController.ImportRegisterDataViaRegisterConnector(args, dt);

return result;

VF UTM_SharedHelper
F UTM_SolutionHelper

catch (Exception ex)
i

throw ErrorHandler.Loghirite(si, new XFException(si, ex));

+7 UTM_XFDocHelper

 WorkfarcePlanningimportRegisterConnector1
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2. Import your data: Navigate to the import function in your planning Register and load from a
local file or an external source. You can import a file and replace all the current data or only

add new rows of data by selecting the append new rows option.

3. Map your data: The solution compares the fields used in your import to the fields that are
defined in your Register Definition. If they match, the data loads into the Add data stage
table. If they do not match, the system will consider that column name as invalid. The stage
table in the Add Data breadcrumb is utilized to validate the data being imported. The
validation checks that the date type matches, invalid members are not imported and

duplicate line items do not exist.

4. Complete the import: Once everything is correctly mapped and all data validations are
successful, save the Register. The system will populate the Register with your data and the

stage table will be cleared.

Add Data to Register

To add data to the Register, follow the legend and corresponding instructions:

o Register
' Import & Modify @&

Import & Modi
E o Calculate & Analyze

©
= Y H @ @

Add Data Manage Filters Spreadsheet Delete All Audit Log

@ = 5 9 B

Editable : EmployeelD : |nstance : FirstName
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Import x
Import Type 6
@ Loadfile (O Load from connector
Import Method @
@ Replace all () Append new rows
@
Register Formulas Settings Help
Import & Modify > AddData e
;
Import
EmployeelD ¢ FirstName ¢ LastName : Entity : Region i CostCenter i Title

—_—

. Hover your cursor over the Register menu.
2. Inthe drop-down menu, select Import & Modify.
3. Click the Add Data button.
4. Click the Import button.
5. Inthe Import pane, select an import type:
a. Select the Load file checkbox to load data from a local file.
b. Select the Load from connector checkbox to load data from an external source.
6. Inthe Import pane, select an import method:
a. Select the Replace all checkbox to replace all data in the Register.

b. Selectthe Append new rows checkbox to only add new rows of data to the

Register.
7. Click the Import button and upload a file.

8. Click the Save To Register button.
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Validations upon import ensure your data is correctly formatted and matches what was set up for

the solution, such as:

* Register column definition: You have a column in your import file that is not defined in the

solution.
* Duplicate column: You have duplicate column headings or values.
* Data type: You have an incorrect data type in one of your columns.

¢ Control list: You have values in a column that do not match the control list values for that

column.
e Connector: You do not have a connector implemented correctly.
* Required column: You do not have data in your required column.

¢ Invalid Value: You have incorrect cultural date or number format values.

Validations upon editing ensure your information does not get removed or go against any

preselected attributes of the solution.

* |f you input the wrong value type in a cell, for example, you enter letters in a column that

should only have numbers, a dialog box opens informing you of an error.

(7) Data Type

Invalid data type detected in the following columnis).

Column T Data Type T

FTE MNumber

Close
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* |fyou try to add or replace any data for a column that has a member definition that you do
not have write access to, a dialog box displays and your change is unsaved. Resolve any
issues before saving again because the solution will not complete a save until all edits are

valid.

@ Invalid Member

Invalid member value detected. The value given either doesn't exist or you
do not have write access to il

ry
]
&
1]

* |fyou try to load and then save a new .csv file that has members that you are not permitted
to edit, a dialog box will display. Only the entities that you have write access to will be

updated and will replace the previous data.

(7) Members

There are one or more members present that you do not have write access
for or that are invalid. Remove the members and reload.
Column T Member T
Entity EUSO1
Close

* If you are missing values in a required column, a dialog box displays.

7} Required Column Validation

FTE is required. Populate with data and relcad.
If this reguirement is in error, reach out to your administrator for assistance.

Close
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If you import a .csv file with numbers used at the beginning of a column name or spaces used in a
column name, the application automatically adds the prefix of Col_ to ensure the import is usable

and compatible with the solution.

NOTE: If you import a .csv file that has different member definitions than what you
defined in the Setup Wizard or Configuration import, a dialog box displays informing

you of an invalid member.

Modify Data in the Register

1. Locate the data: Navigate to the data you want to modify. This involves searching for a

specific individual or record, or filtering the Register to display certain data.

2. Edit the data: Once you've located the data, select the field you want to edit. This enables
you to directly input new data or select from a drop-down menu. You must have security

access to edit data.

3. Save your changes: After editing the data, ensure you save your changes. This is done by

clicking Save button.

Editing the Register

You can edit the Register by using the Spreadsheet tool or the Register grid controls.

The Register uses the Dynamic Grid enabling you to add, remove, cancel all changes prior to
saving, and save Register values. You can also select a cell in the Register and a list of drop-
down values will display based on member definitions, control lists, or parameter values assigned

from the Register Definition.
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00600
@-=+ =% O B

Editable : Employ... : Instance

—

. Insert Row

I NOTE: When you insert a row, default values will automatically populate.

2. Delete Row(s)
3. Cancel all changes prior to saving

4. Save

All of these functions are tied to security access, so if you do not have security access to delete
rows, you will not be able to perform that action. You can view the Editable column to verify which
rows of information you have read/write access to. A checked box indicates read/write access. If
you make edits to information you do not have access to, a dialog box displays and the

information will remain.
Spreadsheet Tool

The Spreadsheet tool opens a new page which enables you to make edits to your Register and
not have to upload a new set of data every time you need to make an update. The tool enables
you to edit a single cell, edit multiple cells at once, copy and paste from cell to cell, copy and paste

arow to a new row, right-click and insert a row, and delete rows.

The spreadsheet tool also utilizes drop-down menus within cells in a column. These drop-down
menus populate from control lists and parameters that have been assigned in the Register

Definition for a quick way to make updates and avoid invalid entries.

To edit your Register using the Spreadsheet tool, follow the legend and corresponding

instructions:
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o Register
'Import & Modify &

Import & Modi
3 1y Calculate & Analyze

o
= Y H @ @

Add Data Manage Filters Spreadsheet Delete All  Audit Log

© = 59O B

Editable : EmployeelD : Instance

*

FirstName

Import & Modify > Edit Data e o
& =3

B C D E F G &
1 Emploveell Firztiame LaztName Entity Fegion CostCenter Tim

1. Hover your cursor over the Register menu.

2. Inthe drop-down menu, select Import & Modify.

3. Click the Spreadsheet button.

4. Complete edits and click the Save button.

5. Click the X button to navigate back to the Register read-only page.

NOTE: When scrolling through your data, the header row remains fixed at top of the

spreadsheet so you do not lose track of which column the information is in.

Certain validations are put in place to make sure your information does not get removed or go

against any preselected attributes of the solution, such as:

Line Item Modeling Guide 46



Register

* Columns cannot be removed if selected column data is being used in a formula. To remove
the column data, formula information must be updated to reflect the change you want to

make.

() Validation

Calumn name changes or addition of new columns must be performed in
the solution settings. Reach out to your administrater for assistance. All other
edits have been saved.

Close

* When editing the Register, you cannot update the column name or add a new column. If
you right-click on a column, the Insert and Delete selections are unavailable. If changes are
made to the column name and other row information, a dialog box displays and only the row

information changes are saved.

(7) Validation

Calumn name changes or addition of new columns must be performed in
the solution settings. Reach out to your administrator for assistance. All other
edits have been saved.

Close

View Data

To view your Register data or plan data, use the pagination tools. Users are only able to view the

Register information they have security access to.

EO0D312 EUSO01 USNE CCi101 Supervisor Exempt
EO0D313 EUSO01 USNE CCi01 Supervisor Exempt
4 4 1 2 3 4 5 6 7 8 9 10] .. > ] 1-50 of 4999 items
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1. Skip to the first

2. Navigate to the previous page
3. Selectapage

4. Navigate to the next page

5. Skip to the last page

6. Number of rows

7. Total number of rows

Delete Rows

To delete rows in the Register, you must have security access.

To delete a row, follow the legend and corresponding instructions:

= Y BH Q@ Q

Add Data Managears Spreadsheet Delete All  Audit Log

CE-NEA RS @a

Editable :  Entity : EmployeelD
o EUSO1 E000238
EUSO1 E000244

1. Selectarow.
2. Click the Delete Row(s) button.

3. Click the Save button.
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Delete All Rows

To delete all rows in the Register using the Delete All action, you must have the Delete All

Register Rows (Bulk) action permission.

IMPORTANT: The Delete All action deletes all rows, not just the rows you have write

access to.

To delete all rows, click the Delete All button. A validation message displays to confirm the

deletion.

I NOTE: Plan data and Register filter groups will remain.

Import & Modify

= Y H @ @

Add Data Manage Filters Spreadsheet | Delete All | Audit Log

+ — O HI|E

|Editahle Y EmployeelD ¥ Instance Y FirstName Y

Audit Log

The Audit Log provides a detailed history of data changes in the Register and allows you to track
who made them. It is read-only and can be viewed if you have security access. Only saved

changes display in the Audit Log.

To view the Audit Log, follow the legend and corresponding instructions:
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Import & Modify

Y

=3

Add Data Manage Filters Spreadsheet Delete All

+ = O H |

o Register

H @ Q

Audit Log

&

! Import & Modify g
Calculate & Analyze

Register

|Editahle Y EmployeelD YT Instance T FirstName Y LastName YT Ent

1. Hover your cursor over the Register menu.

2.

In the drop-down menu, select Import & Modify.

3. Click the Audit Log button and a new page opens.

"%

Type T

Delete All Grid/Spreadsheet

Source hd

Update  Grid/Spreadsheet
Insert Grid/Spreadsheet
Delete Grid/Spreadsheet

Original Data hd

NA

Employeell»=E000236,
FirstName=Alicia, LastMName= Entity=EUSO1,
Region=USNE, CostCenter=CC101, Title=Manager,
Status=Exempt, FTE=1.00000, StartDate=Feb 12 2008
12:004M, EndDate=, Grade=40.00000,
Salary=96800.00000, Hourly=, Bonus=0.02700,
HRStatus=Active, Reason=

Instance=0.00000,

EmployeeID=E000234,
FirstName=Aaron, LastName= B Entity=EUSO1,
Region=USNE, CostCenter=CC101, Title=Manager,
Status=Exempt, FTE=1.00000, StartDate=Apr 20 2000
12:004M, EndDate=, Grade=40.00000,
Salary=106480.00000, Hourly=, Bonus=0.02700,
HRStatus=Active, Reason=

Instance=0.00000,

The Audit Log displays the following columns:

Audit Log

Y User T

Admin

Changed Data

Region=USSE Admin

EmployeelD=, Instance=0.00000,
FirstName=Mark, LastName= ’
Entity=EUS01, Region=USSE, CostCenter=CC101,
Title=, Status=, FTE=1.00000, StartDate=Jan 1
1900 12:00AM, EndDate=Jan 1 1900 12:00AM,
Grade=0.00000, Salary=0.00000, Hourly=0.00000,
Bonus=0.00000, HR5tatus=, Reason=

Admin

Admin

Date/Time T

5/28/2025 1:46:32 PM

5/28/2025 1:46:12 PM

5/28/2025 1:46:12 PM

5/28/2025 1:46:12 PM
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* Type: Displays the type of change made such as Delete, Delete All, Update, Insert,

Transfer or Import.

I NOTE: The Audit Log history will remain when the Delete All action is used.

* Source: Displays the source of the change such as Grid, Spreadsheet, Append-File,
Replace all-File, Replace all-connector or Append-connector.

* Original Data: Displays all column values of the original data.

° If datais inserted, the Original Data cell is blank since there is no previous

information.
° If data is imported by a file or a connector, the Original Data cell displays NA.

° |fthe Delete All action is used, the Original Data cell is blank since all data was

removed.

° Ifthe Transfer feature is used, the Original Data cell is blank since a new row is

added to the Register once a transfer is complete.
* Changed Data: Displays the specific changed data.

° If the specific data is removed or the Delete All action is used, the Changed Data cell

is blank since the data was removed.
° |f datais imported by a file or a connector, the Changed Data cell displays NA.
° If datais inserted, the Changed Data cell displays all column values of the new data.
* User: Displays who made the change.

e Date/Time: Displays when the change was made.
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Transfer

The Transfer feature enables you to manage employee transfers between different parts of your
business such as departments, entities or cost centers and execute the transfer in the Register.
When you click the transfer button, a separate transfer pane opens for editing the employee
Register information. Only users with the Manage Transfers action security permission can utilize

the Transfer feature and view the transfer changes in the Register.

IMPORTANT: The Transfer feature is only available in the Workforce Planning

configuration.

Execute Transfer

To execute a transfer, follow the legend and corresponding instructions:
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Import & Modify

=
Add Data  Manage Filters  Spreadsheet Delete All  Audit Log

@ S 5 O
Editable : Entity
e EUS01

EUSD1
EUS01
EUSD1
EUS01
EUSD1
EUSD1
EUS01
EUSOD1
EUS01
EUSD1
EUS01
EUS01
EUSD1
EUS01
EUSOD1

B

Employe...
E0Q00234
E000236
E0Q00238
E000244
EOQOO248
E000248
E000250
EQ00253
E000261
EQ00262
E000274
E0Q00285
EQ00293
EQ00305
EQ00312
E000313

"3 o

Transfer

Register

Region
USNE
USMNE
USNE
USNE
USNE
USNE
USMNE
USNE
USNE
USNE
USNE
USNE
USNE
USNE
USNE
USNE

10

¢ CostCenter

CC101
CCl01
CCim
CCl01
CC1n
CC102
CCl01
CC101
CC101
CC101
CCi01
CC1m
CCl01
CCi01
CC101
CCl10

]

1. Click the Transfer button. The Transfer pane opens.

2. Inthe Register, select a row.

3. Inthe Transfer pane, update Register fields.

Transfer

Select group

All Employees +

Register Fields Values

Entity
Region
CostCenter
Title
Status
FTE

Start Date
Grade
Salary
Bonus
HRStatus

Cancel

EUSO01

USNE

CC101
Manager
Exempt
1.00000
04/20/2000
40.00000
106480.00000
0.02700

Active

Execute Transfer

NOTE: You have access to Register fields that have the Allow Updates or

Required column enabled in the Register Definition.

4. Click the Execute Transfer button. A new row is added to the bottom of the Register.

I NOTE: The start date of the Transfer becomes the end date of the initial row.
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Manage Filters

After a Register is saved, you can use the Manage Filters button to set specifications to populate

distinct sets of information. You can select a variety of factors in the filter tool to create new

conditions or groups.

To create a new filter, follow the legend and corresponding instructions:

Register o
= Y H

Add Data Manage Filters Spreadsheet

Bonus FTE InPer QutPer
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= H @ Q

Add Data Spreadsheest Delete All  Audit Log
Filter Group Manager

And

FirstName Equals

APPLY CLEAR

Filter group name:
®@C .
1. Click the Manage Filters button and a new pane will open.
2. Click the And button and a drop-down menu will open to display options: And, Or.

3. Click the plus button to display options: Add Condition or Add Group.

NOTE: For self-hosted environments, Click the drop-down arrow next to the plus

icon to display the options.
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7.

Click the first box to display a drop-down menu of your columns. Make a selection.
Click the second box to display a drop-down menu of operations. Make a selection.
Click the third box, and type in the value you want to filter for.

Click the Apply button.

After the filter has finished running, your Register view displays the filtered data as well as an

updated row and page count.

Save a Filter

To reuse afilter, save it as a group and avoid recreating filters.

To save afilter as a group, follow the legend and corresponding instructions:
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Import & Modify e
_— Select group
Add_g-ata Spreghﬂt Degﬂll Au%_ug Tr;:fer All Employees ~
Filter Group Manager @ S5 5 O B Register
Aol Editable ¢ Entity ¢ Employe... ¢ Region
EmployeelD  Equals  <enter a value> SR E000254 DSHE
EUSO01 EQ0D236 USNE
EUSO1 E0Q0D238 USNE
EUSO1 E000244 USNE
EUSO1 E0Q00248 USNE
EUSO1 E000D248 USNE
EUSO1 E0Q00250 USNE
EUSO1 E000253 USNE
EUSO1 E000261 USNE
EUSO1 EQ0D262 USNE
EUSO1 EQ0D274 USNE
EUSO1 E0Q00285 USNE
EUSO1 E00D293 USNE
EUSO1 EQ00305 USNE
EUSO1 E000312 USNE
EUSO1 E0Q00313 USNE
EUSO1 E000314 USNE
EUSO1 EOO0328 USNE
ElISN1 ENNN328 1ISNE
Filter group name: o
o ®C T < < 1 v > gl

1. With afilter created and applied, locate the text box at the bottom of the Filter Group

Manager pane and add a name.
2. Click the Add/Copy Filter Group button.

3. Thefilter displays in the Select group drop-down menu.

Copy a Filter

To copy a filter, follow the legend and corresponding instructions:
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Register o
= Y H

Add Data Manage Filters Spreadsheet

Bonus FTE InPer ©QutPer

Import & Modify

= B o Q ¢

Add Data Spreadsheet Delete Al AuditLog  Transfer
Filter Group Manager

And

EmployeelD Equals <enter a value>

APPLY CLEAR
Filter group name: o o

®@C o

© =
Editable
4 4

>

)
Entity
EUS01
EUSO1
EUSO1
EUS01
EUS01
EUS01
EUS01
EUSO1
EUSO1
EUS01
EUS01
EUS01
EUS01
EUSO1
EUS01
EUS01
EUS01
EUS01

ElISnd

I'=]

1]

Select group o

All Employees «

Register
Employe... Region
E000234 USNE
E000236 USNE
E000238 USNE
E000244 USNE
E000248 USNE
E000248 USNE
E000250 USNE
E000253 USNE
E000261 USNE
E000262 USNE
E000274 USNE
E000285 USNE
E000293 USNE
E000305 USNE
E000312 USNE
E000313 USNE
E000314 USNE
E000328 USNE
ENNNT2R 1ISNF

l

Line Item Modeling Guide

58



Register

1. Click the Manage Filters button.
2. Select afilter group from the drop-down.
3. Add a new Filter Group Name.

4. Click the Add/Copy Filter Group button.

Update a Filter

To update afilter, follow the legend and corresponding instructions:

Register

<)
= Y H

Add Data Manage Filters Spreadsheet

Bonus FTE InPer ©QutPer
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— Select group e

- E Q Q Test -
Add Data Spreadsheet Delete All  Audit Log
Filter Group Manager @ S S 9D B

And Editable : EmployeelD
) E000224
FirstName Equals aaron
APPLY CLEAR
L] 4 1 2 ]

Filter group name: e
Test C o
1. Click the Manage Filters button.
2. Select afilter group from the drop-down.
3. Update the filter criteria.
4. Click the Apply button.

5. Click the Update Filter Group button.

Line Item Modeling Guide

60



Register

Delete a Filter

To delete afilter, follow the legend and corresponding instructions:

Register o
= Y 2

Add Data Manage Filters Spreadsheet

Bonus FTE InPer QutPer

—
= »¢
Add Data Spreadsheet Delete Al Auditlog  Transfer
Filter Group Manager

And

EmployeelD Equals E00D0234

APPLY CLEAR

Filter group name: e
filter ®C o

© s 5 9B

Editable :  Entity
EUS01
4 2] 1 3 »

Select group

e filter v

Register
i Empl...

E00D23-

1-1of 1items
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1. Click the Manage Filters button.
2. Select afilter group from the drop-down.

3. Click the Delete Filter Group button.

I NOTE: You cannot delete a filter group being used in a formula.

Calculate and Analyze

1. Use Built-in Calculation Functions: Most planning registers or management software
have built-in calculation functions. The Line Item Modeling solution offers DateDIFF
(Month), DateDIFF(Year), DateDIFF(Day), IIF, CurrentPeriod, AND, OR, ISNULL,

RollingPeriod, and CurrentYear functions.

2. Create Custom Formulas: If the built-in functions are insufficient, you can create custom
formulas. See Formulas. This enables you to combine data in unique ways to identify

insights, specific to your needs.

3. Apply Calculations to Data Groups: You can apply these calculations to specific groups
of data created by the filter builder. For example, you might calculate the average skill level
of employees in a certain department or the total hours worked by employees on a specific

project.

Analyze Data in the Planning Register

To narrow your analysis, you can filter and sort your data by using the Manage Filters button. See
Manage Filters. For example, you might filter to only show data from a certain time period or sort
data by highest to lowest values. You can also add more Register columns to a plan for reference.

See Plan Data.
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Formulas

Formulas in OneStream's Line Item Modeling solution are used to leverage Global Drivers,
Lookup Drivers, and Cube Drivers to create meaningful and accurate calculations and develop
driver-based operational plans. They can be applied to a wide range of data fields, from basic

arithmetic operations to complex business calculations.

Register Formulas Settings Help
Formulas
- -
® o | 7§
New Edit Copy Delete
© O B
Enabled i Calculation Name : Scenario Type ¢ Account : Period : Register Group ¢ Value Type : Calculation Definition
a MthlySalary All Scenario Types 50200 - Month. M1,M2,M3,M4, Exempt Employees Periodic FTE*Salary/12
a DisabilityBen All Scenario Types 50150 - ST Dis_.  M1,M2,M3,M4,. All Employees Periodic MthlySalary*Dish Ins R

Workforce Planning Use Case

This Use Case demonstrates the following situation:

* Scenario: Build a set of formulas to determine if the federal tax amount still applies for
an employee in a specific month.
* Role: Implementer, Administrator

* Benefits: Formulas can be individually created and the accounts applied to the formulas
can be used as dependencies or building blocks for more advanced formulas to

calculate more complex data.

See Workforce Planning FUTA Formula Use Case for more information.
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Global Drivers

Global Drivers in OneStream's Line Iltem Modeling solution are key variables or factors that can
be used in formulas. These drivers can be financial indicators that are common concepts across
organizations, for example, merit, bonus, tax limits and percentages, benefit amounts, and
vacation days. Global Drivers can be used when you have a static value that can be used across

all time or dimensions (one driver with one value).

By using Global Drivers, organizations can align their planning processes, improve accuracy, and
enhance the comparability of results across different units or departments. It is a powerful tool for
strategic planning, budgeting, and forecasting, helping decision-makers understand the impact of

various factors on the company's performance.

IMPORTANT: Any attribute named in the solution, such as Register Field Names,
Accounts, Global Drivers, Cube Drivers, Lookup Drivers and Formula Names, must be

unique from each other.

Import Global Drivers

To import a bulk file of Global Drivers, follow the legend and corresponding instructions:
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Register 0 Formulas
" Global Drivers 9

Cube Drivers

9 Formulas

Global Drivers

+

Fn;:urt
@ = = O &

Mame : Display Name : Value :
SickPayFactor Sick Pay Factor 0.00500
VacationFactor Vacation Factor 0.01500

2 Open X
4 * » This PC » Downloads v |0 Search Downloads p=]
Organize » Mew folder E= » [ 0
Attachments A MName Date mcdiﬂec\l’ A
B Deskiop Les v e 7se i

1
@ Documents @ Global Drivers 1
Meetings 12
Microsoft Copilot Chat Files 12
Microsoft Teams Chat Files 1
1

&= Pictures

Eileleartes || v| Al Files () -

o

1. Hover your cursor over the Formulas menu.
2. Inthe drop-down menu, select Global Drivers.
3. Click the Import button.

4. Select afile in the dialog box and then click the Open button.

I NOTE: You cannot save if there is a duplicated Name or Display Name.
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To update or add to the current Global Drivers, you can import an updated .csv file or use the
Global Drivers grid controls. In the Global Drivers grid, you can add, remove, cancel all changes

since last save, and save Global Drivers.

) To Insert, click the + button.
* Toremove, click the = button.

* To cancel all changes prior to saving, click the o button.

* To save, click the H  pution.

I NOTE: Global Drivers that are referenced in a saved formula cannot be removed.

When you import a new .csv file, that file is compared with the current list of Global Drivers.
Drivers that are not used in a saved formula are removed if they are not included in the imported
file. Drivers that are used in saved formula are retained, even if they are not included in the

imported file.

NOTE: If you import a .csv file with numbers used at the beginning of a column name or
spaces used in a column name, the application will automatically add the prefix Col__to

ensure the import is usable and compatible with the solution.
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Cube Drivers

Cube Drivers take the dimensionality of cubes used across OneStream and enables you to utilize
their information for formula building and plan data creation within the Line Item Modeling solution.
You can connect driver values from a Cube View to the solution by adding a Cube Driver. The
Cube Driver is dynamic and changes based on any Cube View changes. When creating a Cube
Driver, you can select the Variable option for Time Frequency to track values across multiple
months and years to view all potential results from different time periods or you can select Fixed

which will take the value of the specific month and year the driver is stored in.

NOTE: A Cube Driver can be utilized across multiple years in the plan calculation,

however, the Preview table of the Cube Driver only displays values for a single year.

On the Cube Drivers page, Cube Driver Names and Display Names are stored in the table on the
left and the associated cube driver values are presented in the table on the right. When you select
a Cube Driver from the table on the left, the cube driver values will display in the table on the right.

A Cube Driver may be tied to multiple entities, each with unique values.

NOTE: When you import a configuration, Cube Driver values won't display in the
preview table until you add Register data and preview the new data. Your Cube Driver is
trying to compare values that are in the Register against values that are in a Cube so

data needs to exist in the Register for that comparison to happen.

IMPORTANT: Any attribute named in the solution, such as Register Field Names,
Accounts, Global Drivers, Cube Drivers and Formula Names, must be unique from each

other.
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Cube Drivers

S 1
Add Edif Delate
Name
FicaRateCD

RetirementRate

Register Formulas Settings Help
DEpName @  FicaRateCD (FICA Rate Cube Dvr)
FICA Rate Cube Dwr Entity T Value T
Retirement Match Rate
EUS99 ul

When adding or editing a cube driver, you can use the Global checkbox to control whether a cube

driver applies universally or only to specific dimensions. When selected, the driver is applied to all

Register records, and the corresponding dimension column is removed from the preview. If left

unchecked, the driver applies only to the selected dimension, and those columns remain visible in

the preview. This setting ensures flexibility in managing calculations and configurations. Global

checkboxes only display if a Member Definition is assigned in the Register Definition for a given

Dimension.

I NOTE: Global selections are preserved when exporting configuration files.

Dimensions

Reset | Global @

Enity |

| O

Consolidation | Local

View | Periodic

Account | Grade |Grade| Merit Increase %

Flow | EndBalload

Origin | Before Adj

[s3 | None

w0t |

a

U0z | EMEA

a
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Add Cube Drivers

There are two methods for adding Cube Drivers: copying and pasting the member script
information from a cube view POV within the OneStream application or manually selecting all

criteria.

You also can apply the column name of a Register field in the Account or UD dimension for a cube
driver by typing the column name in between pipes. The pipe substitution variable using a
Register column name dynamically injects the values from that column and will match values
stored in the cube to generate a preview for those intersections. This allows you to leverage

alternate Register fields that don't have a member definition assigned.

Example: Input the Register column name Grade Level in the

Account dimension as |GradeLevel|. Do not include spaces.

To add a Cube Driver by using the Member Script Helper, follow the legend and corresponding

instructions:

NOTE: When you use a Top level cube in a member script, the solution finds the base
cube level of which the Entity and the dimension resides in and will preview the data

from that base cube.

Cube Drivers

Add Cube Driver(s)

Mame Display Name
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Cube Drivers Add Cube Driver

Member Script Helper 9

Name o Display Name e Cube Time Frequency  Time Scenario
Fixed v| Select Time Select Scenario

Dimensions Reset Global @ o

Entity a Entity T Value T
Consolidation
View
Account
Flow
Origin
IC

ubD1 O

uD2

1. Onthe Cube Drivers page, click the Add button.

2. Paste the member script from your cube view in the Member Script Helper field.

NOTE: If a dimension is blank, all the values for that dimension will dynamically be

pulled based on member definition. If you do not populate Entity, all Entity values

from the Register are compared to the cube Entities and data will preview based

on those intersections available. You can also leave a UD blank and if there is

data stored at the UD level, it will retrieve the same way as entities. Leaving a field

blank relies on there being a member definition to use the data from the Register

to dynamically return values based on the intersection of where the data is stored

in the cube.

3. Click the Apply button.

TIP: If you need to update your dimensions, you can click on the Reset button to

clear all your selections and the preview.
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NOTE: If there are multiple cubes referenced in a UD or Flow Register column in
the Register Definition, only the dimension correlating with the cube selection is
utilized.

4. EnteraName.

5. Enter a Display Name.

6. Selecta Time Frequency. Select Fixed for a single value based on the time selection.

Select Variable for the values across the time selection.

7. Select a Global checkbox to control whether a cube driver applies universally or only to that

specific dimension.

8. Click the Preview button.

NOTE: Ifthere is an invalid data intersection, a message box displays and you will

need to update your selections on the Add Cube Driver page.

9. Click the Save button.

IMPORTANT: The Save button displays once the preview table is populated

successfully with no invalid intersections.

To add a Cube Driver without using the Member Script Helper, follow the legend and

corresponding instructions:

Cube Drivers

L1

s o
Add Edit Dedste
Name : Display Name
FicaRateCD FICA Rate Cube Dwr
RetirementRate Retirement Match Rate
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Cube Drivers Add Cube Driver

Member Script Helper

Name 9 Display Name e Cube o Time Frequency  Time G Scenario o
Fixed v Select Time Select Scenario m
Dimensions Reset Global 9 9 m
Entity = Entity hd Value T

Consolidation
View
Account
Flow
Origin
Ic

uD1 [m]
upz
uD3
up4
uDs
ube
uo7
ubs

1. Onthe Cube Drivers page, click the Add button.
2. EnteraName.

3. Enter a Display Name.

4. From the Cube drop-down menu, select a Cube.

5. Selecta Time Frequency. Select Fixed for a single value based on the time selection.

Select Variable for the values across the time selection.
6. Selecta Time.
7. Select a Scenario.

8. Select the member filters for your dimensions by clicking on each dimension or entering
values in the field. Select a Global checkbox to control whether a cube driver applies

universally or only to that specific dimension.
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If no selection is made, all the values for that dimension will dynamically be pulled based on
member definition. If you do not populate Entity, all Entity values from the Register are
compared to the cube Entities and data will preview based on those intersections available.
You can also leave a UD blank and if there is data stored at the UD level, it will retrieve the
same way as entities. Leaving a field blank relies on there being a member definition to use
the data from the Register to dynamically return values based on the intersection of where

the data is stored in the cube.

TIP: If you need to update your dimensions, you can click on the Reset button to

clear all your selections and the preview.

NOTE: If there are multiple cubes referenced in a UD or Flow Register column in
the register definition, only the dimension correlating with the cube selection is

utilized.

9. Click the Preview button and the table will populate the corresponding member definitions

and values.

NOTE: If there is an invalid intersection of data, a message box displays and you

will need to update your selections on the Add Cube Driver page.

10. Click the Save button.

IMPORTANT: The Save button displays once the preview table is populated

successfully with no invalid intersections.
The values will display in the Cube Drivers table.

I NOTE: You cannot save if there is a duplicated Name or Display Name.
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NOTE: Ensure the entities used in the Register have the Member Property setting of
InUse set to True in order for the Cube Driver dashboard to preview results. This can be

configured in the Entity Dimensions area of the Application tab.

Edit Cube Drivers

To edit a Cube Driver, follow the legend and corresponding instructions:

Register Formulas Settings Help
Cube Drivers
. ] o
’ o
Add Edit Dedate
Seamic. = SRR MAmE @  FicaRateCD (FICA Rate Cube Dvr)
o FicaRateCD FICA Rate Cube Dwr Entity T Value T
RetirementRate Retirement Match Rate
EUS99 a
Cube Drivers Edit Cube Driver
Mamber Script Helper
Name Display Name Cube Time Frequency  Time Scenario e
MeritbyGrade Merit by Grade Equipment Division v Variable ~| 2026 Budget\Working m
Dimensions Reset Global @ e om
Entity =] Entity h 4 CostCenter T Grade h d
Consolidation Local

View Periodic
Account Grade |Grade| Merit Increase %
Flow EndBalLoad

Origin BeforeAdj

Ic None
uD1 CCTop [m]
up2 REGTop
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1. Onthe Cube Drivers page, select a Cube Driver from the table.
2. Click the Edit button.

3. Update all relevant criteria.

4. Click the Preview button.

5. Click the Save button.

Delete Cube Drivers

To delete a Cube Driver, follow the legend and corresponding instructions:

Register Formulas Settings Help
Cube Drivers

] B
® # o
Add Edif Delate

i : ElEe MamE @  FicaRateCD (FICA Rate Cube Dvr)
o FicaRateCD FICA Rate Cube Dwr Entity \ 4 Value  d
RetirementRate Retirement Match Rate
EUS33 a

1. Onthe Cube Drivers page, select a Cube Driver from the table.

2. Click the Delete button.

I NOTE: You cannot delete a cube driver that is being used in a formula.
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Lookup Drivers

Lookup Drivers enable you to utilize values stored in XFC tables (any table with the prefix XFC )

within OneStream for formula and plan creation. Users often store ad hoc data in XFC tables to

avoid unnecessary data inclusion in a cube or the Register. Lookup Drivers provide the ability to

match column names in the Register with the column names in the Lookup table applied. The data

points that match between the Register data and Lookup table within those columns provide a

preview based on the return values drop-down selection that is available via the Lookup table.

If more than one Register field is populated in the Lookup Driver column, the values in the preview

will concatenate the values of the Register Fields and display the Return Value based on those

combinations.

NOTE: When you import a configuration, Lookup Driver values won't display in the

preview table until you add Register data and preview the new data. Your Lookup Driver

is trying to compare values that are in the Register against values that are in a Lookup

table so data needs to exist in the Register for that comparison to happen.

IMPORTANT: Any attribute named in the solution, such as Register Field Names,

Accounts, Global Drivers, Cube Drivers, Lookup Drivers and Formula Names, must be

unique from each other.

Name H Display Name @
BonusByGrade BonusByGrade

c840
EBSO1
ECADL
EMX30
EUSO01

Entity

BonusByGrade (BonusByGrade)
CostCenter T GradeLevel
ccion
ccio1
cciol
ccion

ccio1

Formulas

Y

40.00000 .|

32.00000

41.00000

20.00000

40,00000 .

.018

03

.015

Settings

Bonus
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Add Lookup Drivers

To add a Lookup Driver, follow the legend and corresponding instructions:

Lookup Drivers

o
®

Add

S 1

Edit Delete

Name

BonusByGrade

FXRateByRegion

Lookup Drivers > Add Lookup Driver

Select Table 9

XFC_PLNLookupDrivers

ware @

BonusByGrade

Register Field
EmployeelD
Instance
FirstName
LastName
Entity
Region
CostCenter
Title

Status

FTE

Start Date
End Date
Grade
Salary
Hourly
Bonus
HRStatus

Reason

-5 ) B ]

BonusByGrade Banus

:| Lookup Column : Entity
C840
EBSO1
ECAOL
EMX30
Entity EUsO1
CostCenter
GradeLevel

Display Name
BonusByGrade

FXRateByRegion

Register

T CostCenter 3 GradeLevel
cciot
ccio1
ccio1
ccio1

ccio1

Formulas

T  Bonus
40,00000 .028
32.00000 .018
41.00000 .03
3000000 .015
40.00000 .028

Sattings
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1. On the Lookup Driver page, click the Add button.

2. Inthe Select Table drop-down menu, select an XFC table.

I NOTE: Only tables with the prefix XFC_ can be selected.

3. Click the Apply button.
4. Enteraname.
5. Enter adisplay name.

6. Inthe Return Value drop-down menu, select the column with the driver value you want to

return.

7. Inthe Lookup Column drop-down menus for each Register Field, select a column to map

the Register field value to the Lookup column value. Values must match to return a result.

8. Click the Preview button. The Preview table on the right will populate with data.

9. Click the Save button. Once saved, the Lookup Driver displays in the Lookup Drivers page.

IMPORTANT: The Save button displays once the Preview table is populated

successfully.

Edit Lookup Drivers

To edit a Lookup Driver, follow the legend and corresponding instructions:
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Lookup Drivers

0
@ ¢ 1

Add Edit Delete

Name
© BonusByGrade

FXRateByRegion

Lookup Drivers Edit Lookup Driver

Select Table
XFC_PLNLookupDrivers %

Name Display Name Return Value
BonusByGrade BonusByGrade Bonus

Register Field | Lookup Column : Entity
EmployeelD Cc840
Instance EBSO01
FirstName ECA01
LastName EMX30
Entity Entity EUS01
Region
CostCenter CostCenter
Tite
Status
FTE
Start Date
End Date
Grade Gradelevel
Salary
Hourly
Bonus
HRStatus

Reason

Display Name

BonusByGrade

FXRateByRegion

CostCenter T GradeLevel
cc101
oc101
cciot
cc1o1

cc1o1

1. Onthe Lookup Driver page, select a Lookup Driver.

2. Click the Edit button.

3. Update all relevant criteria.

4. Click the Preview button.

5. Click the Save button.

Formulas
T Bonus
40.00000 028
32.00000 .018
41.00000 .03
30.00000 .015
40.00000 028
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IMPORTANT: The Save button displays once the Preview table is populated

successfully.

Delete Lookup Drivers
To delete a Lookup Driver, follow the legend and corresponding instructions:

Lookup Drivers

@
®@ 4 1

Add Edit Delete
Name : Display Name
@ BonusByGrade BonusByGrade
FXRateByRegion FXRateByRegion

1. Onthe Lookup Driver page, select a Lookup Driver.

2. Click the Delete button.

I NOTE: You cannot delete a Lookup Driver that is being used in a formula.

Formula Wizard

The Formula Wizard provides a guided and intuitive experience for formula creation. It offers

selectable criteria to help generate specific formulas based on the required data. You can only

select criteria to which you have security access.

IMPORTANT: Any attribute named in the solution, such as Register Field Names,

Accounts, Global Drivers, Cube Drivers, Lookup Drivers and Formula Names, must be

unique from each other.
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There is a wide variety of selections and functions available in the Formula Wizard. Review the

following sections to guide you through the process:

* Formula Name: This is a required field that can have a maximum of 100 characters. As a
best practice, create a unique formula name and avoid using the Account Name as the

Formula Name.

* Formula Description: This optional field enables you to add a description for your Formula

Name. It is recommended that you use 100 characters or less.

* Register Group: The Register Group defaults to All Employees for the Workforce Planning
configuration or All Records for the Fixed Term Planning and Duration Based Planning
configurations. If the formula only applies to a filtered data set, select the drop-down menu
to apply a saved Register filter to pare down the calculated data set and remove

unnecessary data points.

* Value Type: Select either Year-To-Date (YTD) to calculate for the cumulative value or

Periodic to calculate the periodic value.

* Account: Informs the calculation engine where to place the result amount for a formula

when calculating a plan.

* Scenario Type: Informs the calculation engine which formulas apply to a plan. If the
formula applies to all scenarios, select All Scenarios. For example, If the formula only

applies to the budget scenario type, select the budget scenario type. See Plan Data.

* Periods: Apply the months you want the formula to be calculated in. You can select all 12
months, a single month, or any combination of months depending on your planning needs.

You can also select the time profile.

TIP: For a detailed list of formulas, see Appendix A.
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Formula Name Formula Description Register Group Value Type
All Employees v Periodic
Account Scenario Type Periods

¥ Select Scenario Type Select Period(s)

The gray area below your selectable criteria is the Formula Preview. When creating a new
formula, this area will display No formula to preview. Once you start building your formula, this
area will dynamically populate a concatenated view of your formula for easier viewing. If the
formula is too long to fit in the space, the formula text will wrap in format and you can scroll down

to view the full formula.

Below the gray Formula Preview is the Formula Block area where you are prompted to add
blocks. The yellow highlighted block is automatically selected so you can freely add blocks and

operations to your formula.

No formula to preview

Start your formula by creating or adding blocks below.

[]

There is an About section available for each formula block type that gives a brief explanation of

how each block functions.The building block options are:

* Operators: These are the mathematical symbols above each of the building block options,
like the equal sign. Click the operator you need, and it will display in the Formula Block

area.
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* Text: In the Text Field, you can type in numbers or certain operators listed in the About Text
description. You can also type in formulas or parts of formulas such as global drivers or

functions to be converted into blocks.

Before you input text, you can use the Separator, Date Format and Number Format drop-
down menus to override your default culture settings. This is helpful if you are trying to copy

in formulas that use a different culture setting.

NOTE: The default value of the Separator, Date Format, and Number Format

drop-down menus is based on your culture settings.

+ - £ f = ( ) < > <= = <> ,
Text Regist Cube Functions Accounts
Separator  Date Format Number Format About Text
ki Midiyyyy i 2 HE00 ki To override your default culture settings for text
. input select a Separator, Date Format, or Number
Text Field Format.

Content populated in the Text block may contain
text, digits, and the following operators + - */ % (=)

Adding a formula via text and clicking Add to
Formula will parse out the text into blocks into the
formula wizard.

Add To Formula

If you would like to reference an Account to the
formula via Text Field, use A#AccountName (ex.
A#50200).

IMPORTANT: When you type in a formula, each block within that typed formula
has to match the specific formula block naming or a validation will display. For
example, if you type in the formula, FTE+Salaries, but the Register column name

is Salary, the formula will not populate until all blocks are valid.
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Partial Text Tokenization

Text Input is partially portioned into blocks. Review the remaining text to ensure field names are written

properly.

Valid Blocks FTE+
Invalid Blocks  Salaries

* Register: The Register tab enables you to select from any of the columns you have

permission to view. When you add a named block, the value tied to the Register field is

used in the formula creation. You can also pin all the fields available in the Register tab by

clicking the Pin button, and they will display in the Recently Pinned pane for easy reuse

when building your formulas.
FTE*Salary/12

« =» B B

Move Left  Move Right Delete Block Clear All Blocks

FrESaianr.B

Text Cu

Select register field

Add To Formula

Recently Pinned

At

Functions Accounts

About Register

Content populated in the Register dropdown is the
columns that you are permitted to see in the
Register. If you would like to include data in your
formula from a register column, select a field and
click the Add Block button.

* Globals: The Globals tab enables you to select from any of the Global Drivers that were

previously imported. When you add a named block, the value tied to the Global Driver is

used in the formula calculation. You can also pin all the fields available in the Globals tab by

clicking the Pin button, and they will display in the Recently Pinned pane for easy reuse

when building your formulas.
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FTE*Salary/12 Recently Pinned -
« » E
- * 1 ) < > <= >= <> 5
Text giste | Cube Functions Accounts
N About Globals
Select driver fCunlz:ll ;‘mglulgle‘(rj_‘ inelr;eb(i‘\%h_a\s dran come i
I{l?en}u igclidg. me vefalueouia a g?:l?@r]? driv‘er‘ z:l\;mie
name of the driver and click the Add Block button
* Cube: The Cube tab enables you to select from any of the Cube drivers added to the
solution. When you add a named block, the value tied to the Cube driver is used in the
formula calculation. You can also pin all the fields available in the Cube tab by clicking the
Pin button and they will display in the Recently Pinned pane for easy reuse when building
your formulas.
FTE*SaiaryHZ Recently Pinned =

« =» B B

MoveLstt  MoveRight Delets Block Clear All Blocks

FTE’WW.EI

Text

Select Cube driver

Add To Formula

Accounts

N About Cube Drivers

Content populated in the Cube Drivers dropdown
«come from the table in the Cube Drivers tab. If you
would like to include the value of a cube driver,
select the name of the driver and click the Add
Block button.
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* Lookup: The Lookup tab enables you to select from any of the Lookup drivers added to the
solution. When you add a named block, the value tied to the Lookup driver is used in the
formula calculation. You can also pin all the fields available in the Lookup tab by clicking the
Pin button and they will display in the Recently Pinned pane for easy reuse when building

your formulas.

it

FTE*SalaryHZ Recently Pinned

« > B ©

Movelelt MoveRight Delete Block Clear All Blocks

d BH B . [
+ = * ! = ( ) < > <= >= <>
Text s Cube Functions Accounts
N About Lookup Drivers
Selact Lookup Dri Content populated in the Lookup Drivers dropdown
e LoD IARE comes from the table in the Lockup dashboard. If

you would like to include the value of the lookup
driver, select the name of the driver and click ‘Add
to Formula’ button

* Functions: The function block content enables you to select from several different

functions that help define your formula.
° DateDiff(day): Returns the number of day boundaries between two dates.
° DateDiff(month): Returns the number of months between two dates.
° DateDiff(year): Returns the number of years between two dates.
° lIF: Returns a value based on the condition of a true or false statement.
° AND: Displays or uses records if all the conditions are true.
° OR: Displays or includes records if any of the conditions are true.

° CurrentPeriod: Applies the current month in the formula.
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° |IsNull: Evaluates if there are blank values in a calculation.
° RollingPeriod: Returns the number of periods in a plan.
° CurrentYear: Returns the current year in the formula.

You can reference the definition for each function to the right of the function blocks in the

About Functions pane.

Function Block Content About Functions

» DateDiff(Day, StartDate, EndDate) will return the |
number of day boundaries between two dates.
= DateDiff(Month, StartDate, EndDate) will return
the number of months between two dates.
- - - - ] DateDiﬂ(Year‘ e EndDate} REERTE
number of years between two dates.
= [IF(Cendition, Value if True, Value if False) will
return a value based on the condition of a true or
false statement.

= CurrentPeriod will apply the current month in the
formula.

= CurrentYear will apply the current year in the
formula

* Accounts: The Account Library enables you to include formulas that are tied to a specific
account as a dependency in a formula you are creating. In the Account Name drop-down
menu, select an account name and a view-only field of the selected account information
such as Account, Calculation Name and Register Group populates. Click the Add Block

button to add that formula as a block into an active formula.

e r = ITI EE | r—-| | | ]
- - < > e= | »= | <>
= B B A ) & = =l =]
Text Register Gl Cube Lookup Functions
Account Name
3
Account Name T Calculation Na T Description T Register Grouy T Calculation De T Period Y
50200 - Monthly MthlySalary mthlySalary all Employees FTE*Salary/12 M1,M2,M3,M4,M5,.
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After you have made all your selections and built your formula using the block options available,
you can view your formula in the Formula Preview and additional buttons will display in your

Formula Builder area:

= B

Move Left  Move Right Delete Block Clear All Blocks
* To move a block to the left, select it and then click the Move Left button.

* To move a block to the right, select it and then click the Move Right button.

* To delete a block no longer needed in your formula, select it and then click the Delete
Block button.

¢ Toremove all blocks, click the Clear All Blocks button.

The Recently Used or Recently Pinned pane will automatically populate based on the blocks you
have used or pinned. This enables you to easily reference blocks that are frequently used.
Clicking the toggle button to switch between the Recently Used and Recently Pinned panes gives
you the flexibility to set your own preferences when building formulas. You can select a block from

either list to insert it into the formula you are working on.

NOTE: After creating, copying, or editing a formula, the last pinned information will

remain.
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Recently Used

Y

=

Create a New Formula

To create a new formula, follow the legend and the corresponding instructions:

Register Formulas
Farmulas
-. T
® o W 7
Mew Edit Copy Delete
Calculation Name Y Description Y Scenario Type T Account
Monthly Salary All Scenario Types 50200 - Monthly Salary
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Formula Name o Formula Description 9

MthiySalary MthlySalary

Account 0 Scenario Type o
-

50200 - Monthly Salary All Scenario Types

FTE*Salary/12

= E

Move Left  Mova Right Delete Block Clear All Blocks

HES;,EW.B

Text

Separator  Date Format Number Format

v Midhyyy = |aamoo -

Text Field

Add To Formula @

1. Click the New button.

2. Name the formula. This step is required.

3. (Optional) Enter a formula description.

Register Group o

All Employees

Periods e

Period(s) Selected

Cube

Value Type e

v Periodic >
Recently Pinned
<= >= <> ,
Functions Accounts
About Text

To override your default culture settings for text
input select a Separator, Date Format, or Number
Format.

Content populated in the Text block may contain
text, digits, and the following operators +-"/% (=)

Adding a formula via text and clicking Add to
Formula will parse out the text into blocks into the
formula wizard.

If you would like to reference an Account to the
formula via Text Field, use A#AccountName {ex.
A#50200).

4. From the Register Group drop-down menu, select a Register Group.

5. From the Value Type drop-down menu, select a Value Type.

6. From the Account drop-down menu, select an Account.

7. Click All Scenario Types to select a Scenario Type.

8. Click Period(s) Selected to select a periods.

Cancel m

9. Build your formula blocks by choosing from operators, Text, Register, Globals, Cube,

Lookup, Functions or Accounts. \When selected, each block is automatically added to the

end of the formula unless otherwise designated.

Line Item Modeling Guide

90



Formulas

10. After you have entered text in the Text Field or selected a block from the Register, Globals
or Cube option, click the Add to Formula button. The block will populate in the formula

preview.

11. Click the Save button.

NOTE: If you click the Create Another Formula button after saving a formula, the
Register Group drop-down menu will be reset to All Employees for the Workforce
Planning configuration or All Records for the Fixed Term Planning and Duration Based

Planning configurations.

Edit Formulas

To edit a formula, follow the legend and the corresponding instructions:

Register Formulas Settings
Formulas

@ o ® 1

Mew Edit Copy Delete

Calculation Name Y Description V¥ Scenario Type T Account

oMnnthI}r Salary All Scenario Types 50200 - Monthly Salary
Disablilty Ben All Scenario Types 50150 - ST Disability

Formula Name Formula Description Register Group Value Type e
MthlySalary Exernpt Exempt Employees *  Periodic CANCEL
Account Scenario Type Periods
50200 - Monthly Salary All Scenario Types Period(s) Selected
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1. Select an existing formula from the formulas page.
2. Click the Edit button. The Formula Wizard will open enabling you to make any updates.

3. Click the Save button.

Copy Formulas

To copy a formula, follow the legend and the corresponding instructions:

Register Formulas

Farmulas

2]

® o | g

Mew Edit Copy Delete

Calculation Name Y Description ¥ ScenarioType T

Monthly Salary All Scenario Types

Disablilty Ben All Scenario Types
Formula Mame Formula Description Register Group Value Type e
MthlySalary Exempt Exempt Employees v Periodic CANCEL

Account Scenario Type Periods

50200 - Monthly Salary ~ All Scenario Types Period(s) Selected

1. Select an existing formula from the grid.

2. Click the Copy button. The Formula Wizard will open, enabling you to make any updates.

NOTE: When a formula is copied, the Formula Name adds the word Copy to the

end of it, and the Formula Description is updated to Copy. Ensure the Formula
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I Name is updated before saving.

3. Click the Save button.

Delete Formulas

You can only delete formulas if you have Manage Formulas security access. See Security.

To delete a formula, follow the legend and the corresponding instructions:

Register Formulas Settings
Global Drivers
Cube Drivers

o Formulas 9
®@ o = 7

Formulas

Mew Edit Copy Delete

Calculation Name Y Description ¥ ScenarioType T Account
Monthly Salary All Scenario Types 50200 - Monthly Salary
Disablilty Ben All Scenario Types 50150 - ST Disability

—

. Hover your cursor over the Formulas menu.

N

. In the drop-down menu, select Formulas.
3. Select a formula from the formula table.

4. Click the Delete button.

Data in an active or unlocked plan linked to a formula will remain until the next time a calculation is

run. If a plan is locked and you delete a formula that is linked to the locked plan, the data will not
change.
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NOTE: You cannot delete a formula that is being used within another formula as a

dependency.

Enable Formulas

You can modify the enablement and execution of formulas in the Formula dashboard to determine
how formulas are used. You can only enable formulas if you have Manage Formulas security
access. When you create, copy or edit a formula, the enable column is automatically set to

enabled.

To enable a formula, follow the legend and corresponding instructions:

Register Formulas Settings
Formulas
L
Hew Edit Copy Drelete
© O B
Enabled ¢ Calculation Name ¢ Scenario Type : Account : Period ! Register Group
MthlySalary All Scenario Types 50200 - Mo M1,M2 M3, Exempt Employees
DisabilityBen All Scenario Types 50150 - ST ..  M1,M2,M3,.. All Employees
MedicalBen All Scenario Types 50100 - Me._. M1,M2,M3,. . All Employees
o WorkersComp All Scenario Types 50120 - Wo._.. M1,M2 M3, . All Employees

1. Select a formula.

2. Inthe Enable column, select the checkbox.

IMPORTANT: You cannot disable a formula that is being used within another formula as

a dependency or enable a formula that contains a disabled formula.
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Plan Data

Plan data is the calculated output of the Line Iltem Modeling solutions. Plans are produced when

your data is calculated using the formulas you create.

Plans Dashboard

Workforce Planning Reqgister Formulas Settings Help
Calculate & Analyze
L] -
® » ® @ o A d Q
Mew Edit Copy Delete View Lock Unlack Plan Log
Plan Name ¢ Scenario Type ¢ Scenario Name ¢ Start Period ¢ Number of Periods ¢ Status
BudgetWorking Budget BudgetWorking 2026 M1 24 Unlocked

The Plans dashboard features all the functions for managing and running calculations on plans.
Within the dashboard, you can see a table of created plans and all criteria related to each plan.

You can also perform and view the following actions depending on your security access:

Create a New Plan

Recalculate a Plan

View Plan

Lock or Unlock Plan
* Delete Plan

* Copy Plan
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* Edit Plan

* PlanLog

* Connector Business Rule
* Data Adapter

¢ Select Workflow

Create a New Plan

To create a new plan, follow the legend and corresponding instructions:

o Register

Workforce Planning Formulas
Import & Modify
Calculate & Analyze Calculate & Analyze 9
3 I =
@ » ® @§ o A d Q
Mew Edit Copy Delete View Lock Unlock Plan Log
Plan Name Scenario Type Scenario Name Start Period
BudgetWorking Budget BudgetWorking 2026 M1
Register Formulas Settings Help

Calculate & Analyze Add Plan o e @ e 9 9 m
Plan Name Scenario Type Scenario Start Year - Period Number of Periods -
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Register Formulas Settings Help

Calculate & Analyze View Plan

FilLer!sults Belef.tlc!umns Plan Name: Budget 2025 Scenaric Type: Budgel Scenario: BudgetV1 Start Period: 2025 M1 Periods: 24 Plan Status: Unlocked

5 5 9D @B Budget 2025

—

. Hover your cursor over the Register menu.
2. Inthe drop-down menu, select Calculate & Analyze.
3. Click the New button.

4. Enter aplan name in the text box.

NOTE: Do not include special characters in the plan name, as the data adapter

will not run if the plan name contains them.

5. Select Scenario Type. A dialog box displays with available options.

NOTE: Selecting your scenario type before selecting your scenario filters down
the available scenario options. If you select your scenario before selecting your
scenario type, you'll see all the scenario base members except for actuals.

6. Select Scenario. A dialog box displays with available options.

7. Select Start Year. A drop-down menu will display years.

8. Select Period. A dialog box displays available months.

9. Select the number of periods using the drop-down menu. You can select up to 120 months.

10. Click the Create Plan button. After the table is created, a CALCULATE button displays.

11. Click the CALCULATE button. A data management job displays showing the progression

of the formulas being calculated. When the calculation is complete and the data
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management job closes, you have to refresh the application to display your results.

I NOTE: The Windows Application refreshes the page automatically.

NOTE: If you do not populate all the necessary criteria, a dialog box displays reminding

you to fill out any remaining items.

To filter your results, you can use the filter editor component. See Manage Filters.

Plan data generates the columns in the table based on the criteria chosen, including any saved
formulas. After the calculation is complete, you can navigate back to the Plans dashboard and
your new plan is listed in the table with all of the chosen criteria including Last Calculation Date
and Last Modified By. When you have other Register columns with member definitions assigned,

those columns show up in the calculated plan data.

Workforce Planning Register Formulas Settings Help

Calculate & Analyze

®@ o ® @ o A d @

Hew Edit Copy Delete View Lock Unlock Flan Log

Plan Name i Scenario Type i Scenario Name i Start Period i Number of Periods i Status
BudgetWorking Budget BudaetWorking 2026 M1 24 Unlocked

Recalculate a Plan

If you update a formula or edit Register or plan data, you can recalculate a saved plan. If you

upload new plan data, you will need to refresh the page. You might consider recalculating when:
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Adding a new employee to the Register

Updating the base wage of the employee

Updating a Global Driver

Updating an existing formula

NOTE: If you delete all Register data and then try to recalculate a plan, a dialog box
displays reminding you to populate Register data. When there is no Register data, the

Calculate button does not display.

To recalculate a plan, follow these steps:

—

. Navigate to the Plans dashboard.
2. Select the plan you want to run a new calculation on.
3. Click the View button.

4. Click the CALCULATE button.

When the calculation is complete, the plan data populates and overwrites the previous data.

View Plan

To view a saved plan, follow the legend and corresponding instructions:
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Workforce Planning o Register Formulas
Import & Modify
Calculate & Analyze o Calculate & Analyze 9
] -

@ » ® @ © A d Q
Mew Edit Copy Delete View Lock Unlock Flan Log

Plan Name : Scenario Type : Scenario Name ¢ Start Period

e BudgetWorking Budget BudgetWorking 2026 M1

1. Hover your cursor over the Register menu.
2. Inthe drop-down menu, select Calculate & Analyze.
3. Selected a previously created plan.

4. Click the View button.

A new page opens and you can view the calculated data of the selected plan. You can use the
Select Columns button to filter and view all the Register columns you have access to within a

selected plan. Use the Filter Results button to create a custom filter. See Manage Filters.

Register Formulas Settings Help
Calculate & Analyze View Plan
Fi\mr!sul(s SEIE(‘.{IC!umns Plan Name: Budget 202 Scenario Type Budget Scenario: BudgetV1 Start Period: 2025 M1 Periods: 24 Plan Status: Unlocked m
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Select Columns

Select columns to display

[_] EmployeelD
[ Firsthame
[ LastName
[ Region

[ Title

) status
OFTE

() Start Date
[] End Date
[] Grade

[ Salary

() Bonus

[ HRStatus
(] Reason

Cancel Update Table

NOTE: If you do not have security access to calculate data or if all Register data is
deleted, the CALCULATE button is not visible on the View Plan page. The
CALCULATE button is unavailable if the plan is locked.
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Lock or Unlock Plan

Once a plan is created and has data, you can lock or unlock plans depending on your security

access. Locking a plan prevents any calculations from being made. Unlocking a plan enables you

to run a calculation.

To lock or unlock a plan, follow the legend and corresponding instructions:

Workforce Planning o Register Formulas
Import & Modify
Calculate & Analyze a Calculate & Analyze e
- -

@ » ® @ o fa d Q
Hew Edit Copy Delete View Lock Unlack Plan Log

Plan Name ! Scenario Type ! Scenario Name : Start Period

9 BudgetWorking Budget BudgetWorking 2026 M1

1. Hover your cursor over the Register menu.
2. Inthe drop-down menu, select Calculate & Analyze.

3. Selectaplan.

4. Click the Lock button to lock the plan or click the Unlock button to unlock the plan. The

Status column will update.

If the plan is locked and you click the View button, the following page will not show the
CALCULATE button. If the plan is unlocked and you click the View button, the CALCULATE

button will be available.
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NOTE: If you do not have security access to lock and unlock plan data, the Lock or

Unlock buttons are not visible.

Delete Plan

If you want to delete a plan, it must be unlocked and finished calculating. If you try to delete a
locked plan, a dialog box informs you that it cannot be removed. If you try and delete a plan that is

calculating, a validation message informs you that calculations are in progress.

To delete a plan, follow the legend and corresponding instructions:

Workforce Planning o Register Formulas
Import & Modify
Calculate & Analyze o Calculate & Analyze e

® o ® @ o A d «

Mew Edit Copy Delete View Lock Unlock Flan Log
Plan Name ! Scenario Type ! Scenario Name :  Start Period
9 BudgetWorking Budget BudgetWorking 2026 M1

—

. Hover your cursor over the Register menu.

N

. In the drop-down menu, select Calculate & Analyze.

w

Select a plan.

4. Click the Delete button.

A dialog box displays to confirm if you want to proceed with removing the selected plan data. If

there is no data in the plan, a dialog box will not display.
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Copy Plan

You can copy a plan to utilize another plan's selected criteria. You can copy a locked plan

because the copy function only copies the plan criteria.

To copy a plan, follow the legend and corresponding instructions:

o Register

Workforce Planning Formulas
Import & Modify
Calculate & Analyze a Calculate & Analyze e
- -
@ o ® T © a4 d Q
Mew Edit Copy Delete View Lock Unlock Plan Log
Plan Name Scenario Type Scenario Name Start Period
9 BudgetWorking Budget BudgetWorking 2026 M1
Calculate & Analyze Copy Plan @ o
Plan Name | Budget 2025 Copy e Scenario Type: Budget Scenario: BudgetV1  StartYear| 2025 ~ Period Selected: M1 Number of Periods | 24 -
Calculate & Analyze View Plan e
Filter Results Select Columns Plan Name: Budget 2025 Copy Scenaric Type: Budget Scenario: BudgetV1 Start Period: 2025 M1 Periods: 24 Plan Status: Unlocked
1. Hover your cursor over the Register menu.
2. Inthe drop-down menu, select Calculate & Analyze.
3. Selectaplan.
4. Click the Copy button.
5. (Optional) Rename the plan.
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NOTE: When a plan is copied, the word Copy is added to the end of the Plan
Name.

6. (Optional) Update plan criteria.

7. Click the Create Plan button.

8. Click the CALCULATE button.

Edit Plan

You can edit a plan to update any of the plan criteria and re-run a calculation. You can only edit an

unlocked plan.

To edit a plan, follow the legend and corresponding instructions:

Workforce Planning o Register Formulas
Import & Modify
Calculate & Analyze Calculate & Analyze e

@f'ol!':‘lﬂﬂﬁ‘@

Mew Edit Copy Delete View Lock Unlock Flan Log
Plan Name : Scenario Type : Scenario Name ¢ Start Period
e BudgetWorking Budget BudgetWorking 2026 M1
Plans Edit Plan e 0
Plan MName Test Scenario Type: Budget Scenario: Budgetv2 Start Year 2025 ¥ Period Selected: M1 Number of Periods 24 A
Calculate & Analyze View Plan 0
Filter Results Select Columns Plan Name: Budget2025 Scenario Type: Budget Scenario: BudgetV1 Start Period: 2025 M1 Periods: 24 Plan Status: Unlocked
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—

. Hover your cursor over the Register menu.

2. Inthe drop-down menu, select Calculate & Analyze.

3. Selectaplan.

4. Click the Edit button.

5. Update plan criteria.

6. Click the Update Plan button.

7. Click the CALCULATE button.

Plan Log

The plan log records information from the last calculation of a plan. You can use the plan log to

audit your plans and verify what entities were calculated for.

To view a plan log, follow the legend and corresponding instructions:

Workforce Planning

Calculate & Analyze

@ o @B §[§ o

Mew Edit Copy Delete View
Plan Name Scenario Type
e BudgetWorking Budget

Scenario Name

BudgetWorking

o Register

Import & Modify
Calculate & Analyze 9

g O

Unlock Flan Log

Formulas

Start Period

2026 M1
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—

. Hover your cursor over the Register menu.

N

. Inthe drop-down menu, select Calculate & Analyze.

w

Select a plan.

4. Click the Plan Log button.

A new page will open, and you can view the filter groups calculated based on the security
assigned, what time the plan was last calculated and who calculated it. The plan log will also

display the number of calculated rows and total rows in the plan.

Calculate & Analyze Plan Log

Plan Name: Budget 2025 Scenario Type: Budget Scenario: BudgetV1 Start Period: 2025 M1 Periods: 24 Plan Status: Unlocked Calculated Row(s): 56 Total Row(s) 56

Filter_Group H Run_By ¢  Run_Date_Time :

r.CostCenter IN {'CC101"... Admin 9/2/2025 5:27:.

Connector Business Rule

A connector business rule is created automatically when you install the solution and captures
relevant column information the entity member definition is assigned to within a plan. That plan
data can then be directly imported to a OneStream workflow profile. You will need a
corresponding Data Source, Transformation Rule, and Workflow Profile to connect the plan
data to the workflow. For example, if you create a Workflow Profile with a scenario type that does
not match the selected plan, the data will not populate and you will have to select the correct

scenario type.

To access the connector business rule, go to Application > Business Rules > Connector and
then locate your planning configuration plan data connector instance. See the example below for

the first instance of the Workforce Planning configuration:
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Business Rules - WorkforcePlanningPlanDataConnector

NI OKHI|®| & w6
V% TLP20_ThingPlanningData - -
Properties
+X TLP20_ThingPlanningData_EntityTin
X TLP20_ThingPlanningData_EntityTout

V% TLP30_ThingPlanningData ' ! Tusing system;
2 using System.Data;
X TLP20_ThingPlanningData_EntityTin J 3 |using System.ling;
J% TLP30_ThingPlanningData_EntityTout ' u=ThgySysten Collections-oenecic;

using OneStream.Shared.Common;

| using OneStream.Shared.Database;

| using OneStream.Shared.Wcf;

using OneStream.Stage.Engine;

| using Workspace.PLNB1.PLN.Controllers;

+x TLP40_ThingPlanningData
+x TLP40_ThingPlanningData_EntityTin
+x TLP40_ThingPlanningData_EntityTout

[T - B T« V) B 4

+x WaorkforcePlanningPlanDataConnectorl 1@
= — 11 Enamespace OneStream.BusinessRule.Connector.WorkforcePlanningPlanDataConnectorl
[ Conditional Rule 12 g
[ Derivative Rule 13 F#region PlanConnector
» [ Cube View Extender i-: =] ?Jhll[ class MainClass
» [ Dashboard Data Set 16 private SessionInfo _sij
4 [ Dashboard Extender v
18 B ///1/ Installer Generated Code - Do Mot Modify ///////
% AAA_WorkflowHelper 19 private PlanDataConnectorController _plnController;
Jx ACMI_Config 28 private string plnType = "2";
i 21 private int plnInstance = 1;
% ACMIElowHlelpers 22 B IELTIEEELE BRI LTI EE L IE IR E IR

Select Workflow

The Line Item Modeling solution enables you to launch multiple workflows for multiple time
periods to export plan data into a workflow and run the plan data through the entire workflow
process and into a cube. The data in the plan table will integrate with the Workflow based on
specific settings around the Can Load Unrelated Entities profile property and the Substitution Text
Strings in the Workflow Profile. When the Can Load Unrelated Entities profile property is set to
True, then the processing of the Plan Data to the Workflow will reference the Substitution Text
Settings populated with PLNEntity=MemberDefinition, and will import data based on security
defined in the solution. When the Can Load Unrelated Entities profile property is set to False, then
the processing of the Plan Data to the Workflow will reference Entity Assignment tab within the
Workflow Profile and match Entities that exist in the plan table to know which Entities to import

(this will be done for users that have write access for the respective Entities).
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Once data is exported, you can navigate to OnePlace > Workflow and select the periods that

were loaded to view the data in the import step.

NOTE: You must have the Manage Plans security permission to use the select workflow

feature.
Workforce Planning o Register Formulas
Import & Modify
Calculate & Analyze o Calculate & Analyze e
- -

@ » ® @ o A d Q
Mew Edit Copy Delete View Lock Unlock Flan Log

Plan Name ! Scenario Type ! Scenario Name :  Start Period

9 BudgetWorking Budget BudgetWorking 2026 M1
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Process x

Scenario: Budget\Working

Cube Root Workflow: | Global GolfStream_PLN v

Workflow

8 o

] Global GolfStream_PLN_Default.Import
Equipment Plan NA.Marketing Register

0

Equipment Plan NA.People Plan

Equipment Plan NA.Skills Register L

Equi Plan NA.D d Register
Equipment Plan NA.Capital Projects
Equipment Plan NA.Import

O0o/bDb|o|Oo|o

Equipment Plan EMEA.Import

Periods

@

 2026M1
2026M2

2026M3
2026M4
2026M5
2026M6&
2026M7

O/D0|DDb|OO|D

2026M8

To export data into a workflow, follow the image and corresponding instructions:

—_—

Hover your cursor over the Register menu.

2. Inthe drop-down menu, select Calculate & Analyze.
3. Selectaplan.

4. Click the View button.

5. Click the Process button.

6. Inthe Cube Root Workflow drop-down menu, select a workflow.
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7. Select the checkbox of a Workflow.

8. Select the checkbox of a Period.
I NOTE: You can select multiple periods.

9. Click the Process button. A message box displays how many rows were loaded for each

period.

Data Adapter

When a plan has calculated data, a permitted user can run a data adapter query to access the
plan. You can do so by going to the Application tab, clicking on Workspaces, opening the
Workforce Planning (PLN) Workspace, expanding Dashboarding > Data Adapters, and selecting
the da_GetPlanData_PLN data adapter.

NOTE: The Data Adapter executes the designated security method to comply with all
solution-specific security configurations within the Line Item Modeling solution. Security

is a critical component of the adapter, ensuring that data accessed outside the solution

continues to adhere to the established security protocols applied to the data set.

) Application Workspaces - da_GetPlanData_PLN (Data Adapter)
[ . FH -cDEFTHNAOO I RGBOHGS O | &% ¢ &=|Dh*|& e

= i :
4 Maintenance Units £ General (Data Adapter) [

» ™ CodeOnly (PLN)

- rkspace

4 ) Dashboarding (PLN)
P Dashboard Groups

Cube View Groups

B Processing
Data Management Groups
Template Parameter Values (e.g. Param1=Valuel, ..}
» Components
Text 1
4 Data Adapters
P Text 2
B da_AuditLog PLN = Data Source
da_CubeBasedDriver Previe
& da_CubeBasedDriver_Preview_PLN Command Type Method
B da_CubeDrivers PLN Method Type BusinessRule
BF oa FiteredRegister PLN Method Query (WS){GetPlanData)(PlanName=(|!Plan Name![] StartDate=[[!Start Date!]). EndDate=[End Date!]. Preview=[|:Data Preview![])

& da_Formula_RequiredGlobals_PLN
B da_GenericDialogTable_PLN
B da_GetPlanData PLN

Results Table Name
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Once the data adapter is selected, click on Run button on the toolbar. Doing so will offer
parameters for you to select the specific Plan Name, option to preview the data, and it's
corresponding Start and End dates. Doing so will provide the resulting query in the Data Preview

along with the total number of rows based on the query parameters.

) Data Preview - da_GetPlanData_PLN

Onginal Guery

{WSHGetPlanData}{PlanName=[|!Plan Name![],StartDate=[|!Start Date!]], EndDate=|lEnd Date!|, Preview=[|!Data "raview!]]}

Substituted Query
WS} {GetPlanData}(PlanName=[Test 1), StartDate=[2025M1), EndDale=2025M2. Preview=[false])

Data Table

Table -

Dcodes Decoded DisplayName RegisterLinelD 2025M1 2025M2
» 200 AM  2/8/2023 12:00:00 AN 12/30/2023 12:00:00 AM Cubp Drver Calc 1 1058160.000 1:)1'9\1 £0.000
w0000 AN 2/6/2023 12:00:00 AN 111572023 12:00:00 AM  Cube Driver Calc

L%

324276000 324276000

20:00 AM  3/14/2023 12:00:00 AM  10/31/2023 12:00:00 AM Cube Driver Calc 3 106417.000 106417.000
20:00 AM  1/5/2023 12:00:00 AN 7/2/2023 12:00:00 AN  Cube Dnver Calc 4 499206.000  499296.000
W00 AM 3/2/2023 1200:00 AN 1072472023 12:00:00 AM  Cube Driver Calc 5 378144000 373144.000
200:00 AV 5/20/2023 12:00:00 AM  7/19/2023 12:00:00 AM  Cube Dnver Calc & 303968.000 303968.000
20:00 AM  4/15/2023 12:00:00 AM  10/18/2023 12:00:00 AM Cube Dnver Calc 7 650190000  650190.000
00 AM 4272023 12:00:00 AN 97972023 1200:00 AM Cube Dniver Calc 3 S75198.000 S7G198.000
00 AM  3/27/2023 12:00:00 AM 1172472023 12:00:00 AM Cube Driver Calc 9 554676.000 554576.000
20 AM  4/23/2023 12:00:00 AM  8/4/2023 12:00:00 AM  Cubwe Driver Calc 10 463165.000 462165000 -
4 -

Total Number Of Rows: 1306

Close
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Workforce Planning FUTA Formula Use Case

Workforce Planning FUTA Formula

Use Case

The following use case provides a detailed look into using formulas in the Workforce Planning

configuration.

Scenario: Build a set of formulas to determine if the federal tax amount applies to an employee in
a specific month. Federal tax calculation compares total monthly earnings of any employee to the

federal tax limit.
Role: Implementer, Administrator

Benefits: Formulas can be individually created and the accounts applied to the formulas can be
used as dependencies or building blocks for more advanced formulas to calculate more complex

data.

You need to create a formula to calculate each category of earnings an employee could have,

then populate the federal tax limit formula. You can create the following example formulas:

* Monthly Salary Formula

* Bonus Calculation Formula

* Merit Calculation Formula

* Total Monthly Salary

* Year-To-Date Salary Formula

* Year-To-Date Salary - Tax Limit Formula
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* Periodic - (YTD-FUTA Limit) Formula
* FUTA Formula
IMPORTANT: There are many ways of creating formulas based on your configured

Register fields, Global Drivers, Cube Drivers, and Register Field Groups. These

formulas are examples to detail a particular use case.

Solution Setup

Before you can create the formulas for this use case, you have to set up the solution by installing

the Workforce Planning configuration. Follow these instructions for an example setup:

1. Set up the solution by using the Setup Wizard.

* Register fields that are needed include: Salary (this field could be a yearly amount),
FTE (this helps determine if the salary is dedicated to one Entity, Region, or Cost

Center or should be split between multiple). For additional information, see Register.

Example:
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O W H Register Definition wl
Register Field Name Y Display Name ¥ Data Type T Date Assignment T Allow Updates T Required Column ¥ Member Definition ¥ Parameter Name Y Default Value T
ployeelD p [o] String Not Used
Instance Instance Number Not Used
FirstName FirstName String Not Used
LastNarme LastMamme String Not Used
Entity Entity String E#GSE.Base E#G5P.Base  Not Used
Region Region String Not Used
CostCenter CostCenter String U1=CC100.Base Not Used
Title Title String Not Used
Status Status String Mot Used
FTE FTE MNumber Mot Used
InPer InPer Mumber Not Used
OutPer QutPer Number Not Used
StartDate Start Date Date Start Date Not Used
EndDate End Date Date End Date Not Used
Grade Grade String Not Used
Salary Salary Number Not Used
Bonus Bonus Number Not Used
HRStatus HRStatUS string Not Used
Reason Reason String Not Used
TermPer TermPer Number Not Used

* Ensure there is an account in your import that can hold your monthly salary amounts.
In this example, Account Name 50200 and Account Description of Monthly Salary are

used. For additional information, see Accounts.

Example:
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4

-

Import

© = 590 B

Account Name ¢ Account Description
50200 Monthly Salary
50210 Salaries Hourly
50220 Bonus
50230 Qvertime
50240 FTO
50250 Merit
50100 Medical Benefits
50120 Workers Compensation
50130 401K
50150 ST Disability
50160 LT Disability
50000 FUTA
50001 SUTA
50030 Medicare
50040 Social Security
50201 YTD Salary
50300 Total Salary
50221 YTD Bonus
50251 YTD Merit
50299 Monthly Total Salary
50202 YTD-FUTA Limit
50203 Periodic-YTD-FUTA Limit

* Security needs to be configured in order to complete the setup wizard. Assign as

necessary. For additional information, see Security.
2. Load Register Data. For additional information, see Import and Modify.

Example:
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Workforce Planning FUTA Formula Use Case

Bonus  FTE
0.02700 1.00000
0.02700 1.00000
0.02700 1.00000
0.02700 1.00000
0.02700 0.70000
0.02700 030000
0.02700 100000
0.02700 1.00000
0.02700 1.00000
0.02700 1.00000

InPer
0.00000
0.00000
0.00000
0.00000
0.00000
0.00000
0.00000
7.00000
0.00000
0.00000

QutPer

Salary EmployeelD Instance

0.00000 106480.00000 E000234

0.00000  96800.00000 E000236

0.00000 159830.00000 EQ00238

0.00000 96250.00000 E000244

0.00000 98200.00000 E000248

0.00000 $8200.00000 E000248

0.00000 116160.00000 E000250

5.00000 105000.00000 EQ00253

0.00000 116160.00000 EQ00261

0.00000 108800.00000 E000262

0.00000
0.00000
0.00000
0.00000
0.00000
1.00000
0.00000
0.00000
0.00000
0.00000

FirstName LastName Entity

Azron
Alicia
Anne
Richard
Michelle
Michelle
Jennifer
Janet
Eric

Angels

Davis
Flynn
Perkins
Reeves
Andersen
Anderson
Adams
Flores
Tapia

Brown

EUSO1
EUSO1
EUSO1
EUSO1
EUSO1
EUSO1
EUSO1
EUSO1
EUSO1
EUs0O1

Region CostCenter Title
USNE  CC101 Manager

USNE  CC101 Manager

USNE  €C101 Sales Director/VP
USNE  €C101 Inside Sales Mgr
USNE  CC101 Manager

USNE  CC102 Manager

USNE  CC101 Manager

USNE  CC101 Inside Sales Mgr
USNE  €C101 Manager

USNE  €C101 Manager

Status
Exempt
Exempt
Exempt
Exempt
Exempt
Exempt
Exempt
Exempt
Exempt

Exempt

StartDate T
1/1/1900 12:00:00 AM
1/1/1900 12:00:00 AM
1/1/1900 12:00:00 AM
1/1/1900 12:00:00 AM
1/1/1900 12:00:00 AM
1/1/1900 12:00:00 AM
1/1/1900 12:00:00 AM
1/1/1900 12:00:00 AM
1/1/1900 12:00:00 AM
1/1/1900 12:00:00 AM

End Date T
1/1/1900 12:00:00 AM
1/1/1900 12:00:00 AM
1/1/1900 12:00:00 AM
1/1/1900 12:00:00 AM
1/1/1900 12:00:00 AM
1/1/1900 12:00:00 AM
1/1/1900 12:00:00 AM
1/1/1900 12:00:00 AM
1/1/1900 12:00:00 AM
1/1/1900 12:00:00 AM

3. Import Global Drivers. For additional information, see Global Drivers.

Example:

Global Drivers

4

Import

©

Name

=

.1

SickPayFactor

‘VacationFactor

WageWhatIf

EUTArate

BonusPer

0 B

Display Name

Sick Pay Factor

‘facation Factor

Wage What If

SUTA rate

Bonus Per

Monthly Salary Formula

Value

0.00500

0.01500

1.02000

0.05000

5.00000

Grade HRStatus Reason TermPer

Active
Active
Active
Active
Split
split
Active
Leave
Active

Active

0.00000
0.00000
0.00000
0.00000
0.00000
0.00000
0.00000
0.00000
0.00000
0.00000

The monthly salary formula is determined by the Full Time Equivalent (FTE) amount multiplied by

the salary and divided by 12.
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Formulas
Formula Name Formula Description Register Group
MthlySalary | All Employees
Account Scenario Type Periods
50200 - Monthly Salary M All Scenario Types Period(s) Selected
FTE*Salary/12

- (@ ©

Move Left Move Right Delete Block Clear All Blocks

fFl'Ef*ESaIaryf/f.D

There are two different options for creating this formula:

e Option 1: Select each formula block.

e Option 2: Type the formula in the text field of the Text tab.

Option 1

Follow these instructions to create this formula by selecting each block:

1. Populate the formula criteria:

* Formula Name: Monthly Salary

(Optional) Formula Description

Register Group: All Employees

Value Type: Periodic

Account: 50200 - Monthly Salary

b

Value Type

Periodic
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* Scenario Type: All Scenarios

* Periods: All periods selected

ormula Name Formula Description

Monthly Salary All Employees - periodic

Account

50200 - Monthly Salary - All Scenario Types Period(s) Selected

2. Click the Register tab, select FTE from the drop-down menu and click the Add To Formula

button.
3. Click the * operator block.

4. Click the Register tab, select Salary from the drop-down menu and click the Add To

Formula button.
5. Click the / operator block.
6. Click the Text tab, type 12 in the text field and click the Add To Formula button.

7. Click the Save button. You will receive a confirmation message with the option to create

another formula or return to the formula library.
Option 2
Follow these instructions to create this formula by typing the formula in the Text tab:

1. Populate the formula criteria:

* Formula Name: Monthly Salary

(Optional) Formula Description

Register Group: All Employees

Value Type: Periodic

Account: 50200 - Monthly Salary
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* Scenario Type: All Scenarios

* Periods: All periods selected

ormula Name Formula Description
Monthly Salary All Employees
Account

50200 - Monthly Salary - All Scenario Types Period(s) Selected

2. Click the Text tab, type FTE*Salary/12 in the text field and click the Add To Formula

button.

3. Click the Save button. You will receive a confirmation message with the option to create

another formula or return to the formula library.

Bonus Calculation Formula

The bonus calculation formula uses a conditional IIF statement to determine if the CurrentPeriod
is equal to the bonus period as defined in the Global Drivers as well as multiplying salary and

bonus percent.

Formula Name Formula Description Register Group Value Type

BonusCalc All Employees - Periodic v
Account Scenario Type Periods

50220 - Bonus v All Scenario Types Pericd(s) Selected

lIF(CurrentPeriod=Bonus Per,Salary*Bonus,0)

There are two different options for creating this formula:

e Option 1: Select each formula block.

e Option 2: Type the formula in the text field of the Text tab.
Option 1

Follow these instructions to create this formula by selecting each block:
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1.

10.

11.

Populate the formula criteria:
* Formula Name: Bonus Calc
* (Optional) Formula Description
* Register Group: All Employees
* Value Type: Periodic
* Account: 50220 - Bonus
e Scenario Type: All Scenarios

* Periods: All periods selected

. Click the Functions tab and select the IIF block.

Click the Functions tab and select the CurrentPeriod block.
Click the = operator block.

Click the Globals tab, select Bonus Per from the drop-down menu and click the Add To

Formula button.
Click the , operator block.

Click the Register tab, select Salary from the drop-down menu and click the Add To

Formula button.
Click the * operator block.

Click the Register tab, select Bonus from the drop-down menu and click the Add To

Formula button.
Click the , operator block.

Click the Text tab, type 0 in the text field and click the Add To Formula button.
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12. Click the Save button. You will receive a confirmation message with the option to create

another formula or return to the formula library.
Option 2
Follow these instructions to create this formula by typing the formula in the Text tab:

1. Populate the formula criteria:
* Formula Name: Bonus Calc
e (Optional) Formula Description
* Register Group: All Employees
* Value Type: Periodic
¢ Account: 50220 - Bonus
e Scenario Type: All Scenarios
* Periods: All periods selected

2. Click the Text tab, type lIF(CurrentPeriod=Bonus Per,Salary*Bonus,0) in the text field
and click the Add To Formula button.

3. Click the Save button. You will receive a confirmation message with the option to create

another formula or return to the formula library.

Merit Calculation Formula

The merit calculation formula uses a conditional |IF statement to determine if the CurrentPeriod is
greater than or equal to merit increase period. If that value is true, the monthly salary will be

multiplied by the merit rate.
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Formula Name Formula Description Register Group Value Type
MeritCalc Merit Calc All Employees - Periodic
Account Scenario Type Periods

50250 - Merit v All Scenario Types Period(s) Selected

IIF(CurrentPeriod>=Merit Incr Per,A#50200*Merit Rate Ex,0)

There are two different options for creating this formula:

e Option 1: Select each formula block.

¢ Option 2: Type the formula in the text field of the Text tab.
Option 1
Follow these instructions to create this formula by selecting each block:

1. Populate the formula criteria:
* Formula Name: Merit Calc
* (Optional) Formula Description
* Register Group: All Employees
* Value Type: Periodic
* Account: 50250 - Merit
e Scenario Type: All Scenarios
* Periods: All periods selected
2. Click the Functions tab and select the lIF block.
3. Click the Functions tab and select the CurrentPeriod block.

4. Click the >= operator block.

5. Click the Globals tab, select Merit Inc Per from the drop-down menu and click the Add To

Formula button.
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6. Click the, operator block.

7. Click the Accounts tab, select 50200 from the Account Name drop-down menu, select the

Monthly Salary formula and click the Add Block button.
8. Click the * operator block.

9. Click the Globals tab, select Merit Rate Ex from the drop-down menu and click the Add To

Formula button.
10. Click the , operator block.
11. Click the Text tab, type 0 in the text field and click the Add To Formula button.

12. Click the Save button. You will receive a confirmation message with the option to create

another formula or return to the formula library.
Option 2
Follow these instructions to create this formula by typing the formula in the Text tab:

1. Populate the formula criteria:
* Formula Name: Merit Calc
* (Optional) Formula Description
* Register Group: All Employees
* Value Type: Periodic
* Account: 50250 - Merit
e Scenario Type: All Scenarios
* Periods: All periods selected

2. Click the Text tab, type lIF(CurrentPeriod>=Merit Incr Per,A#50200*Merit Rate Ex,0) in
the text field and click the Add To Formula button.
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3. Click the Save button. You will receive a confirmation message with the option to create

another formula or return to the formula library.

Total Monthly Salary

After you have created a monthly salary, bonus, and merit formula, you can create a formula that
adds all of those calculations together. This formula utilizes the IsNull block from the Functions tab
which determines if there are blank values for a specific period in the calculated results from the
monthly salary, bonus, and merit formulas. You can enter a 0 in the IsNull calculation to replace
any blank values to make sure there is no impact to the overall calculation. For example, if a
bonus calculation for a given month is $1000 and the IsNull function is used with a value of 0 for all
other periods, the bonus calculation will remain at $1000. If you use a value of 1 in the IsNull
calculation, then the bonus calculation for the year would be $1,011 (based on the 11 months

carrying a 1 dollar value).

Formula Name Formula Description Register Group Value Type
TTL Mthly Sal TTL Mthly Sal All Employees v Periodic
Account Scenario Type Periods

50299 - Monthly Total Salary v All Scenario Types Period(s) Selected

IsNull(A#50200,0)+IsNull(A#50220,0)+IsNull(A#50250,0)

There are two different options for creating this formula:

e Option 1: Select each formula block.

e Option 2: Type the formula in the text field of the Text tab.
Option 1

Follow these instructions to create this formula by selecting each block:
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1. Populate the formula criteria:
* Formula Name: Total Monthly Salary
* (Optional) Formula Description
* Register Group: All Employees
* Value Type: Periodic
e Account: 50299 - Monthly Total Salary
e Scenario Type: All Scenarios
* Periods: All periods selected
2. Click the Functions tab and select the IsNull block.
3. Select the vertical ellipses to the right of the IsNull block.

4. Click the Accounts tab, select 50200 from the Account Name drop-down menu, select the

Monthly Salary formula and click the Add Block button.
5. Select the vertical ellipses after the next comma block.
6. Click the Text tab, type 0 in the text field and click the Add To Formula button.
7. Select the vertical ellipses after the next comma block.
8. Click the + operator block.
9. Click the Functions tab and select the IsNull block.
10. Select the vertical ellipses to the right of the IsNull block.

11. Click the Accounts tab, select 50220 from the Account Name drop-down menu, select the

BonusCalc formula and click the Add Block button.
12. Select the vertical ellipses after the next comma block.

13. Click the Text tab, type 0 in the text field and click the Add To Formula button.
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14.

15.

16.

17.

18.

19.

20.

21.

Select the vertical ellipses after the next comma block.

Click the + operator block.

Click the Functions tab and select the IsNull block.

Select the vertical ellipses to the right of the IsNull block.

Click the Accounts tab, select 50250 from the Account Name drop-down menu, select the
Merit Calc formula and click the Add Block button.

Select the vertical ellipses after the next comma block.

Click the Text tab, type 0 in the text field and click the Add To Formula button.

Click the Save button. You will receive a confirmation message with the option to create

another formula or return to the formula library.

Option 2

Follow these instructions to create this formula by typing the formula in the Text tab:

1.

Populate the formula criteria:

Formula Name: Total Monthly Salary
(Optional) Formula Description
Register Group: All Employees

Value Type: Periodic

Account: 50299 - Monthly Total Salary
Scenario Type: All Scenarios

Periods: All periods selected

2. Click the Text tab, type IsNull(A#50200,0)+IsNull(A#50220,0)+IsNull(A#50250,0) in the
text field and click the Add To Formula button.
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3. Click the Save button. You will receive a confirmation message with the option to create

another formula or return to the formula library.

Year-To-Date Salary Formula

The year-to-date salary formula is similar to the total monthly salary formula except that it

calculates a year-to-date value type instead of a periodic.

Formula Name Formula Description Register Group Value Type
TTL Mthly Sal YTD TTL Mthly Sal YTD All Employees - YTD
Account Scenario Type Periods

50201 - YTD Salary v All Scenario Types Period(s) Selected

1sNull(A#50200,0)+IsNull{A#50220,0)+IsNull{ A#50250,0)

Follow these instructions to create a year-to-date salary formula using example data and

dependency formulas:

1. Select the Total Monthly Salary formula from the formula dashboard and click the Copy
button.

2. Update the Formula Name to YTD Salary.
3. From the Value Type drop-down menu, select YTD.
4. From the Account drop-down menu, select 50201 - YTD Salary.

5. Click the Save button. You will receive a confirmation message with the option to create

another formula or return to the formula library.

Year-To-Date Salary - Tax Limit Formula

The year-to-date salary - tax limit formula determines the difference between the YTD salary and
the FUTA limit.
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Formula Name Formula Description Register Group Value Type
YTD - FutaLimit ¥TD - FutaLimit All Employees v Periodic
Account Scenario Type Periods

50202 - YTD-FUTA Limit v All Scenario Types Period(s) Selected

IsNull(A#50201,0)-Federal Tax Limit

There are two different options for creating this formula:

* Option 1: Select each formula block.

e Option 2: Type the formula in the text field of the Text tab.
Option 1
Follow these instructions to create this formula using example data and dependency formulas:

1. Populate the formula criteria:
* Formula Name: YTD - FUTA Limit
* (Optional) Formula Description
* Register Group: All Employees
* Value Type: Periodic
* Account: 50202-YTD-FUTA Limit
* Scenario Type: All Scenarios
* Periods: All periods selected
2. Click the Functions tab and select the IsNull block.
3. Select the vertical ellipses to the right of the IsNull block.

4. Click the Accounts tab, select 50202 from the Account Name drop-down menu, select the
YTD Salary formula and click the Add Block button.

5. Select the vertical ellipses after the next comma block.
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6. Click the Texttab, type 0 in the text field and click the Add To Formula button.
7. Select the vertical ellipses after the next parentheses block.
8. Click the - operator block.

9. Click the Globals tab, select the Federal Tax Limit from the drop-down menu and click the
Add To Formula button.

10. Click the Save button. You will receive a confirmation message with the option to create

another formula or return to the formula library.
Option 2
Follow these instructions to create this formula by typing the formula in the Text tab:

1. Populate the formula criteria:
* Formula Name: YTD - FUTA Limit
* (Optional) Formula Description
* Register Group: All Employees
* Value Type: Periodic
* Account: 50202 - YTD-Futa Limit
e Scenario Type: All Scenarios
* Periods: All periods selected

2. Click the Text tab, type IsNull(A#50201,0)-Federal Tax Limit in the text field and click the
Add To Formula button.

3. Click the Save button. You will receive a confirmation message with the option to create

another formula or return to the formula library.
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Periodic - (YTD-FUTA Limit) Formula

The Periodic - (YTD - FUTA Limit) formula determines the difference between the total monthly

salary formula and the year-to-date - FUTA Limit formula.

Formula Name Formula Description Register Group Value Type
Periodic - YTD - FutaLimit Periodic - YTD - FutaLimit All Employees v Periodic
Account Scenario Type Periods

50203 - Periodic-YTD-FUTA Limit v All Scenario Types Period(s) Selected

IsNull(A#50299,0)-(IsNull(A#50201,0)-Federal Tax Limit)

There are two different options for creating this formula:

e Option 1: Select each formula block.

e Option 2: Type the formula in the text field of the Text tab.
Option 1
Follow these instructions to create this formula using example data and dependency formulas:

1. Populate the formula criteria:
e Formula Name: Periodic - (YTD - FUTA Limit)
¢ (Optional) Formula Description
* Register Group: All Employees
* Value Type: Periodic
* Account: 50203 - Periodic - (YTD - FUTA Limit)
* Scenario Type: All Scenarios
* Periods: All periods selected

2. Click the Functions tab and select the IsNull block.
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3. Select the vertical ellipses to the right of the IsNull block.

4. Click the Accounts tab, select 50299 from the Account Name drop-down menu, select the

Total Monthly Salary formula and click the Add Block button.
5. Select the vertical ellipses after the next comma block.
6. Click the Texttab and type 0 in the text field and click the Add To Formula button.
7. Select the vertical ellipses after the next parentheses block.
8. Click the - operator block.
9. Click the Functions tab and select the IsNull block.
10. Select the vertical ellipses to the right of the IsNull block.

11. Click the Accounts tab, select 50201 from the Account Name drop-down menu, select the
YTD Salary - Tax Limit formula and click the Add Block button.

12. Select the vertical ellipses after the next comma block.

13. Click the Text tab, type 0 in the text field and click the Add To Formula button.
14. Select the vertical ellipses after the next parentheses block.

15. Click the - operator block.

16. Click the Globals tab, select the Federal Tax Limit from the drop-down menu and click the
Add To Formula button.

17. Click the ) operator block.

18. Click the Save button. You will receive a confirmation message with the option to create

another formula or return to the formula library.
Option 2

Follow these instructions to create the formula by typing in the Text tab:
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1. Populate the formula criteria:
* Formula Name: Periodic - (YTD - FUTA Limit)
* (Optional) Formula Description
* Register Group: All Employees
* Value Type: Periodic
* Account: 50203 - Periodic - (YTD - FUTA Limit)
e Scenario Type: All Scenarios
* Periods: All periods selected

2. Click the Text tab, type IsNull(A#50299,0)-(IsNull(A#50201,0)-Federal Tax Limit) in the
text field and click the Add To Formula button.

3. Click the Save button. You will receive a confirmation message with the option to create

another formula or return to the formula library.

FUTA Formula

The FUTA formula utilizes two IIF statements. The first is used to determine if the year-to-

date salary is less than or equal to the federal tax limit. If it is, then the calculation will apply the
total monthly salary multiplied by the FUTA rate. If the first IIF statement is false and the federal
tax limit is surpassed, then the calculation will apply the difference between the total monthly

salary and the result of the (YTD Salary - Tax Limit) value multiplied by the FUTA rate.

Formula Name Formula Description Register Group Value Type
FUTA Calc FUTA Calc All Employees v Periodic
Account Scenario Type Periods

50000 - FUTA v All Scenario Types Period(s) Selected

IIF(A#50201<=Federal Tax Limit,Federal Tax Rate*A#50299,IIF(A#50203<0,0,A#50203*Federal
Tax Rate))

There are two different options for creating this formula:
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e Option 1: Select each formula block.

* Option 2: Type the formula in the text field of the Text tab.

Option 1

Follow these instructions to create this formula using example data and dependency formulas:

1. Populate the formula criteria:

2. Click the Functions tab and select the IIF block.

Formula Name: FUTA
(Optional) Formula Description
Register Group: All Employees
Value Type: Periodic

Account: 50000 - FUTA
Scenario Type: All Scenarios

Periods: All periods selected

3. Click the Accounts tab, select 50201 from the Account Name drop-down menu, select the

YTD Salary formula and click the Add Block button.

4. Click the <= operator.

5. Click the Globals tab, select Federal Tax Limit from the drop-down menu and click the

Add To Formula button.

6. Click the, operator block.

7. Click the Globals tab, select Federal Tax Rate from the drop-down menu and click the Add

To Formula button.

8. Click the * operator block.
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10.

11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

Click the Accounts tab, select 50299 from the Account Name drop-down menu, select the
Total Monthly Salary formula and click the Add Block button.

Select the vertical ellipses after the next comma block.
Click the Functions tab and select the IIF block.

Click the Accounts tab, select 50203 from the Account Name drop-down menu, select the
Periodic-(YTD-FUTA Limit) formula and click the Add Block button.

Click the < operator block.

Click the Text tab, and type 0 in the text field and click the Add To Formula button.
Select the vertical ellipses after the next comma block.

Click the , operator block.

Click the Accounts tab, select 50203 from the Account Name drop-down menu, select the
Periodic-(YTD-FUTA Limit) formula and click the Add Block button.

Click the * operator block.

Click the Globals tab, select Federal Tax Rate from the drop-down menu and click the Add

To Formula button.
Click the ) operator block.

Click the Save button. You will receive a confirmation message with the option to create

another formula or return to the formula library.

Option 2

Follow these instructions to create this formula by typing the formula in the Text tab:
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1. Populate the formula criteria:
* Formula Name: FUTA
* (Optional) Formula Description
* Register Group: All Employees
* Value Type: Periodic
* Account: 50000 - FUTA
e Scenario Type: All Scenarios
* Periods: All periods selected

2. Click the Texttab, and type lIF(A#50201<=Federal Tax Limit,Federal Tax
Rate*A#50299,lIF(A#50203<0,0,A#50203*Federal Tax Rate)) in the text field and click
the Add To Formula button.

3. Click the Save button. You will receive a confirmation message with the option to create

another formula or return to the formula library.
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Help and Miscellaneous

Information

@ Access the help documentation.

Display Settings

OneStream Solutions frequently display multiple elements for data entry and analysis. We
recommend you set your screen resolution to a minimum of 1920 x 1080 for optimal form and
report rendering. Adjust the Windows System Display text setting to 100% and do not apply

Custom Scaling options.

Package Contents and Naming Conventions

The package file name contains multiple identifiers that correspond with the platform. Renaming
any of the elements contained in a package is discouraged in order to preserve the integrity of the

naming conventions.

Example Package Name: PLN PV9.0 SV120 PackageContents.zip
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Identifier Description

PLN Solution ID

PV9.0.0 Minimum Platform version required to run solution
SV120 Solution version

PackageContents File name

OneStream Solution Modification

Considerations

A few cautions and considerations regarding the modification of OneStream Solutions:

* Major changes to business rules or custom tables within a OneStream Solution will not be
supported through normal channels as the resulting solution is significantly different from

the core solution.

* [f changes are made to any dashboard object or business rule, consider renaming it or
copying it to a new object first. This is important because if there is an upgrade to the
OneStream Solution in the future and the customer applies the upgrade, this will overlay
and wipe out the changes. This also applies when updating any of the standard reports and

dashboards.
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* [f modifications are made to a OneStream Solution, upgrading to later versions will be more
complex depending on the degree of customization. Simple changes such as changing a
logo or colors on a dashboard do not impact upgrades significantly. Making changes to the
custom database tables and business rules, which should be avoided, will make an

upgrade even more complicated.
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Appendix A: Workforce Planning

Formulas

The following table is a detailed list of some Workforce Planning sample formulas.

Formula Description Calculation Logic Calculation Definition
Monthly This is the FTE*Salary/12 FTE*Salary/12
Salary amount of
money an
employee
earnsina
month.
Bonus Thisisanextra | IIF [IF(CurrentPeriod=Bonus

payment given (CurrentPeriod=Bonus | Per,Salary*Bonus,0)

toan Per,Salary*
employee on Bonus,0)
top of their

regular salary.
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Formula Description Calculation Logic Calculation Definition
Merit This often IIF [IF(CurrentPeriod>=Merit Incr
refersto a (CurrentPeriod>=Merit | Per,A#50200*Merit Rate
system where Incr Per, Ex,0)
pay increases Monthly Salary*Merit
are based on Rate Ex,0)
employee
performance.
Medical These are FTE*Health Ins FTE*Health Ins Rate/12
Benefits health-related Rate/12
benefits
provided by an
employer.
Workers This insurance | Workers Comp [IF(A#50200>0,Workers
Comp type pays for Rate*Monthly Comp Rate*A#50200,0)
medical care Salary
and physical
rehabilitation
of employees
injured on the
job.
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Formula

Disability

Description

This insurance
type pays a
portion of an
employee's
salary fora
period of time
if they are
unable to work
due toinjury or

illness.

Calculation Logic

Disb Ins Rate*Monthly
Salary

Calculation Definition

A#50200*Disb Ins Rate
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Formula

Description

Calculation Logic

Calculation Definition

FUTA

This is short
for Federal
Unemploymen
t Tax Act,
which is a tax
that employers
pay to the
federal
government to
fund state
workforce
agencies.
These
agencies
provide
unemployment
benefits to
people who
have lost their

jobs.

[IF(Total YTD
Salary<=Federal Tax
Limit,Federal Tax
Rate*Total

Monthly Salary,lIF
(PartialLimitCalc<0,0,
PartialLimitCalc*Feder
al Tax Rate))

[IF(A#50201<=Federal Tax
Limit,Federal Tax
Rate*A#50299,IIF
(A#50203<0,0,A#50203*Fed

eral Tax Rate))
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Formula

SUTA

Description

This is short
for State
Unemploymen
t Tax Act,
which is a tax
that funds
programs and
benefits for
unemployed

citizens.

Calculation Logic

SUTA rate*Monthly
Salary

Calculation Definition

A#50200*SUTA rate

PTO Vacation

This is short
for paid time
off, which is a
policy that
allows
employees to
take time off
from work
while still being

paid.

Vacation

Factor*Monthly Salary

A#50200*Vacation Factor
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Formula

PTO Sick

Description

This is short
for paid time
off, which is a
policy that
allows
employees to
take time off
from work due
toillness, while

still being paid.

Calculation Logic

Sick Pay
Factor*Monthly Salary

Calculation Definition

A#50200*Sick Pay Factor
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Appendix B: Custom Service

Factory

The purpose of the Custom Service Factory is to provide a method in which you can add
customizations to the solution. You can add custom events for components, Dynamic Grid, and
the SQL.

IMPORTANT: Maintain your assembly as customizations will NOT remain in place

during a solution upgrade.

NOTE: The Custom Service Factory includes the ability to modify the table view service
for the register editor. The table name for the register editor is already present in the
custom service factory code and does not need to be changed. Other areas of the

Custom Service Factory have placeholders such as my component or my grid name.

Set Up the Custom Service Factory

1. Onthe Application tab click Workspaces > Line Iltem Modeling > Maintenance Units >
CodeOnly (PLN) > Files.

2. Inthe Files folder, click CustomServiceFactory_PLN.zip.
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CnePlace

Application EESEAEN
4 [ Cube
%, Dimensions
() Time Profiles
@ Cubes
&) FX Rates
4 3 Workflow
*3 Workflow Channels
Workflow Profiles
|2 confirmation Rules
@ Certification Questions
4 By Data Collection
¥ Data Sources
=3 Transformation Rules
Form Templates
Journal Templates
4 @ Presentation
iB Books
HH Cube Views
Workspaces

4 » Tools

# | @) Application Workspaces - CustomServiceFactory PLN.zip (File)

4
.4
.4

F |

% 3+ | "k B F 5 B ET B HEC
Workspaces
Default
Capital Lifecycle Management
People Planning {(PLM)
4 Maintenance Units
4 ™ CodeOnly [PLN)
Dashboard Groups
Cube View Groups
P Data Management Groups
Components
Data Adapters
P Parameters
4 Files
appsettingsjson
CustomServiceFactory_PLMN.zip
DEInstall_PLN.zip
UninstallDB_PLN.sql
Strings

P Assemblies

3. Inthe General (File) pane, click Download File and save the file to an appropriate

location.

4. Onthe Application tab, click Tools > Load/Extract.

5. Onthe Load tab, locate CustomServiceFactory PLN.zip usingthe Select File icons

and click Open.
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Change Assemblies Setting upon Install

1. Onthe Application tab click Workspaces > Line Iltem Modeling > Maintenance Units >
CodeOnly (PLN).

2. Update the Workspace Assembly Service: CustomEventHandler
PLN.WsAssemblyFactory

(7)) Application Workspaces - CodeOnly (PLN) (Maintenance Unit)

S | B B g 5 BETEEITI P OHS O &4+ 124 =8 - |
Pl Workspaces i B General (Maintenance Unit)
L Default Name CodeOnly (PLN)
4 Capital Lifecycle Management Workspace People Planning (PLN)
4 People Planning (PLM) Description
4 Maintenance Units Is Mobile False

B Assemblies

4 [ CodeOnly (PLN) )
Dashboard Groups :Workspace Assembly Service ! CustomEventHandler_PLN.WsAssemblyFactory

e
Cube View Groups Bl security

Access Group Everyone
» Data Management Groups

Maintenance Group Everyone
Components

3. Onthe Application tab click Workspaces > Line Item Modeling.

4. Update the Workspace Assembly Service: CustomEventHandler
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PLN.WsAssemblyFactory

4 Workspaces § @ General (Workspace)
4 Default Name
» Capital Lifecycle Management ipg;qippipr; 77777777777777777777777777777777777777
4 People Planning (PLN) Notes
4 Maintenance Units Substitution Variable items
» [ CodeOnly [PLN) B Security

» [ Dashboarding (PLN) Access Group

Maints G
» [ Formulas (PLN) aintenance Group

sh
& Dashboard Profiles B Sharing

& Cube View Profiles Is Shareable Workspace
Shared Workspace Names

B Assemblies
Namespace Prefix
Imports Namespace 1
Imports Namespace 2
Imports Namespace 3
Imperts Namespace 4
Imports Mamespace 5
Imports Mamespace &
Imports Namespace 7
Imports Namespace &
Waorkspace Assembly Service

B Text

Maintain Assembly

—

People Planning (PLN)

(Collection)

Everyone
Everyone

True

PLN

CustomEventHandler_PLN.WsAssemblyFactory

On the Application tab, click Tools > Load/Extract > Extract.

2. Inthe File Type drop-down menu, select Application Workspaces.

3. Inthe ltems to Extract drop-down menu, unselect All.

4. Click Workspaces > Line Item Modeling > Maintenance Units > Workspace

Assemblies.

5. Select CustomEventHandler_PLN.

6. Click the extract button 9
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Example

Here is an example method that checks the titles of user-entered data in the Dynamic Grid for an

empty or Boss value and substitutes them with the Team Leader value.

using OneStream.Shared.Common;
using OneStream.Shared.Wcf;

using OneStreamWorkspacesApi.V800;
using System;

namespace Workspace. WsNamespacePrefix. WsAssemblyName
{
public class WsDynamicGridService : IWsasDynamicGridv800
{
public XFDynamicGridGetDataResult GetDynamicGridData (SessionInfo si, BRGlobals
brGlobals, DashboardWorkspace workspace, DashboardDynamicGridArgs args)
{
try
{
if ((brGlobals != null) && (workspace != null) && (args != null))
{
return Workspace.
WsNamespacePrefix.PLN.WsDynamicGridController.GetDynamicGridData (si, brGlobals, workspace,
args) ;
}
return null;
}
catch (Exception ex)
{

throw new XFException(si, ex);

public XFDynamicGridSaveDataResult SaveDynamicGridData (SessionInfo si, BRGlobals
brGlobals, DashboardWorkspace workspace, DashboardDynamicGridArgs args)
{
try
{
// DO NOT MODIFY THIS METHOD ALL CHANGES SHOULD BE ADDED INSIDE THE
BEFORE/AFTER EVENT METHODS

if ((brGlobals != null) && (workspace != null) && (args != null))
{

BeforeEvent (si, brGlobals, workspace, args);

// Insert logic here to save modified rows.

XFDynamicGridSaveDataResult result = Workspace.
WsNamespacePrefix.PLN.WsDynamicGridController.SaveDynamicGridData (si, brGlobals, workspace,
args) ;

AfterEvent (si, brGlobals, workspace, args, result);
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return result;

return null;
}
catch (Exception ex)

{
throw new XFException(si, ex);

private static void BeforeEvent (SessionInfo si, BRGlobals brGlobals,
DashboardWorkspace workspace, DashboardDynamicGridArgs args)
{
// GET FUNCTION NAME FROM COMPONENT SELECTION CHANGED SERVER TASK ARGUMENTS
if (args.Component.Name.XFEqualsIgnoreCase ("dg Register Insert Delete PLN"))
{
MyCustomBeforeEvent (si, args);

private static void AfterEvent (SessionInfo si, BRGlobals brGlobals,
DashboardWorkspace workspace, DashboardDynamicGridArgs args, XFDynamicGridSaveDataResult
taskResult)

{

// GET FUNCTION NAME FROM COMPONENT SELECTION CHANGED SERVER TA
if (args.Component.Name.XFEqualsIgnoreCase ("ComponentName"))

{

K ARGUMENTS

MyCustomAfterEvent (si) ;

// PUT CUSTOM METHODS HERE
private static void MyCustomBeforeEvent (SessionInfo si, DashboardDynamicGridArgs

args)
{
if (args.SaveDataArgs != null)
{
foreach (XFEditedDataRow row in args.SaveDataArgs.EditedDataRows)
{
if (row.InsertUpdateOrDelete == DbInsUpdateDelType.Insert)
{
var titleValue = row.ModifiedDataRow.Items.ContainsKey ("Title") ?
row.ModifiedDataRow.Items["Title"]?.ToString() : null;
if (string.IsNullOrWhiteSpace (titleValue) || titleValue == "Boss")
{
row.ModifiedDataRow.Items["Title"] = "Team Leader";

private static void MyCustomAfterEvent (SessionInfo si)
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)D CUSTOM AFTER EVENT CODE HERE
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